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0.Vorwort

Wir danken Ihnen, dass Sie sich für unser Produkt entschieden haben.
Dieses Handbuch beschreibt, wie Sie die e-Filling Funktionen dieses Systems benutzen können. 
Bitte lesen Sie dieses Handbuch, bevor Sie die Funktionen verwenden.

Über dieses Handbuch

 Symbole in diesem Handbuch
In diesem Handbuch sind wichtige Hinweise durch folgende Symbole gekennzeichnet. Lesen Sie diese Hinweise, 
bevor Sie das System benutzen.

 Zielgruppe für dieses Handbuch
Dieses Handbuch richtet sich an allgemeine Anwender und an Administratoren.

 Modellserien in diesem Handbuch
In diesem Handbuch werden die einzelnen Modellnamen durch einen Seriennamen ersetzt.

 Optionales Equipment
Zu den verfügbaren Optionen siehe nachfolgende Referenz: 
Systeminformationen - Systeminformationen - Optionen

 Displayanzeigen in diesem Handbuch
 Für dieses Handbuch werden die Menü- und Dialogfenster von Windows 10 verwendet.
 In einzelnen Punkten können die Bildschirminhalte in der Praxis abweichen, da sie vom aktuell verwendeten 

Modell, der Systemumgebung, z.B. installierten Optionen, der verwendeten OS-Version und von den installierten 
Applikationen abhängig sind.

 Die Abbildungen der Bildschirme in diesem Handbuch wurden in der Papiereinstellung für das A/B Format erstellt. 
Wenn Sie als Papiereinstellung das LT Format verwenden, kann die Anordnung der Tasten von Ihrem System 
abweichend sein.

Diese Gefahrenstufe weist auf eine potenziell gefährliche Situation hin, die - wenn sie nicht 
behoben wird - tödliche bzw. ernsthafte Verletzungen, erhebliche Schäden oder Feuer im 
Gerät oder in seiner Umgebung nach sich ziehen kann.

Diese Gefahrenstufe weist auf eine potenziell gefährliche Situation hin, die - wenn sie nicht 
behoben wird - geringfügige bis mittlere Verletzungen, Teilschäden am System oder in seiner 
Umgebung sowie Datenverlust nach sich ziehen kann.

Kennzeichnet Informationen, die Sie bei der Bedienung des Systems beachten sollten.

Beschreibt praktische Tipps zur Bedienung des Systems.

Referenzen, auf denen Sie weitere Hinweise finden können. Lesen Sie diese Referenzen bei 
Bedarf.

Modellname Serienname

e-STUDIO2020AC/2520AC e-STUDIO6525AC Serie

e-STUDIO2525AC/3025AC/3525AC/4525AC/5525AC/6525AC

e-STUDIO2528A/3028A/3528A/4528A/5528A/6528A e-STUDIO6528A Serie

e-STUDIO6526AC/6527AC/7527AC e-STUDIO7527AC Serie

e-STUDIO6529A/7529A/9029A e-STUDIO9029A Serie

Hinweis

Tipp
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 Abkürzungen in diesem Handbuch
In diesem Handbuch werden der “Dual Scan Dokumenteneinzug” (DSDF) und der “Automatische Wendeeinzug” 
(RADF) gemeinsam als “Automatischer Dokumenteneinzug” (ADF) bezeichnet.

 Handelsmarken
Zu den Handelsmarken siehe Sicherheitsinformationen.
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0.e-Filing Merkmale

e-Filing ist auf dem Internen Datenspeicher des Systems installiert. Mit e-Filing können Sie Dokumente speichern und 
gespeicherte Dokumente drucken, bearbeiten und verwalten.
Dieser Abschnitt beschreibt das Speichern von Dokumenten in e-Filing.

 Öffentliche Box
Die öffentlich Box ist standardmäßig in e-Filing enthalten. Alle Anwender können darauf zugreifen, daher ist es 
sinnvoll, dort häufig benötigte Dokumente zu speichern. Da es sich bei der öffentlichen Box um eine integrierte 
Systembox handelt, sind Namensänderung/Neuerstellung/Löschen der Box nicht möglich. Um dem Administrator 
den Zugriff auf die öffentliche Box zu ermöglichen, kann hierfür ein Kennwort vergeben werden. Wenn dies 
eingestellt wurde, ist die Eingabe eines Kennworts erforderlich. Zu Einzelheiten über die 
Authentifizierungseinstellung der öffentlichen Box siehe nachfolgende Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Authentifizierungseinstellungen - 
Authentifizierung öffentliche Box

 Benutzerbox
Jeder Anwender kann unter e-Filing eine persönliche Benutzerbox erstellen. Der Zugriff auf die Benutzerbox kann 
durch ein Kennwort geschützt werden. Daher ist sie besonders für spezielle Anwender und Administratoren zum 
Speichern von vertraulichen Dokumenten geeignet. Die Benutzerbox kann auch ohne Kennwort erstellt werden. In 
diesem Fall können alle Anwender auf die Benutzerbox zugreifen. (Bis zu 200 Benutzerboxen können erstellt 
werden.)

Zu Einzelheiten über die Kennworteinstellung der Benutzerbox siehe nachfolgende Referenz:
 S.29 “Benutzerboxen erstellen”

 Ordner
In jeder Box können Ordner erstellt werden. Es können jedoch nur Ordner der ersten Ebene erstellt werden. Die 
Erstellung von Unterordnern innerhalb von Ordnern ist nicht möglich.
(Bis zu 100 Ordner können in einer Box erstellt werden.)

Bedienfeld Client Computer

Dokumente die durch 
Kopieren/Scannen 
gespeichert wurden

Dokumente die durch 
Drucken (Druckertreiber) 

gespeichert wurden

Dokumente die durch 
Internet-Faxempfang/Fax 

gespeichert wurden

Alle Anwender

Bestimmte Anwender 
(oder Administratoren)

Ordner

Benutzerbox

Ordner

Öffentliche Box
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 Dokumente
Dokumente können mit folgenden Methoden in der Box oder einem Ordner gespeichert werden.
(Bis zu 400 Dokumente können in einer Box oder einem Ordner gespeichert werden. / Jedes Dokument kann bis zu 
200 Seiten enthalten.)
- Kopieren und Speichern in e-Filing
- Scannen und Speichern in e-Filing
- Drucken von einem Clientcomputer und Speichern in e-Filing
- Empfangene Internetfaxe / empfangene Faxe mit der Weiterleitungsfunktion in e-Filing speichern. 
- Empfangene Internetfaxe / empfangene Faxe mit der Mailbox-Weiterleitungsfunktion in e-Filing speichern.

Hinweis

 Um Faxfunktionen zu verwenden, muss die Faxeinheit im System installiert sein.
 Je nach Menge der in e-Filing gespeicherten Daten, kann es einige Zeit dauern, bis die e-Filing Funktion nach dem 

Einschalten des Systems zur Verfügung steht.
 Wird versucht, mehr als die verfügbare Anzahl an Dokumenten zu speichern, schlägt das Speichern in e-Filing fehl.

Löschen Sie nicht benötigte Dokumente regelmäßig aus der Box oder aus e-Filing. Alternativ können Sie eine 
Speicherdauer festlegen, nach der die Dokumente automatisch gelöscht werden.
 S.27 “Dokumente löschen”
 S.45 “Box-Eigenschaften ändern”

Tipp

 Zu den Einzelheiten der Weiterleitungsfunktionen siehe nachfolgende Referenz:
TopAccess - [Administration] - [Registration] ([Administration]) Elemente - Weiterleitung empfangener Faxe 
und Weiterleitung empfangener Internetfaxe

 Zu den Einzelheiten der Mailboxfunktionen siehe nachfolgende Referenzen:
Faxfunktionen - BENUTZEN DER FAXEINHEIT (HILFREICHE FUNKTIONEN) - Mailboxfunktion verwenden
TopAccess - [Administration] - [Registration] ([Administration]) Elemente - Weiterleitung empfangener Faxe und 
Weiterleitung empfangener Internetfaxe
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0.e-Filing Funktionen

Funktionen für dieses System
Die nachfolgende Liste enthält die über den Touch Screen verfügbaren e-Filing Funktionen. Zu den Einzelheiten dieser 
Funktionen siehe angegebene Referenzseiten.

 Dokumente drucken
Mit den folgenden Funktionen können Sie in e-Filing gespeicherte Dokumente drucken.
 Gesamtes Dokument drucken
 S.14 “Dokument vollständig drucken”

 Bestimmte Seiten eines Dokuments drucken
 S.17 “Testdruck”

 Dokumente speichern
Mit den folgenden Funktionen können Sie in e-Filing Dokumente speichern.
 Dokumente kopieren und speichern
 S.19 “Kopieren und Speichern in e-Filing”

 Dokumente scannen und speichern
 S.24 “Scannen in e-Filing”

 Dokumente löschen
Dokumente in e-Filing löschen
 S.27 “Dokumente löschen”

 Benutzerboxen/Ordner verwalten
Mit den folgenden Funktionen können Sie Benutzerboxen und Ordner in e-Filing verwalten. Das Erstellen und 
Bearbeiten von Ordnern innerhalb von Boxen ist über den Touch Screen nicht möglich. Ordner können nur mit einem 
Clientcomputer erstellt und bearbeitet werden.
 Neue Benutzerboxen erstellen
 S.29 “Benutzerboxen erstellen”

 Name und Kennwort einer Benutzerbox ändern
 S.30 “Benutzerboxen bearbeiten”

 Benutzerboxen und Ordner löschen
 S.31 “Benutzerboxen/Ordner löschen”
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Funktionen in Verbindung mit einem Clientcomputer
Die e-Filing Funktionen der nachfolgenden Liste stehen nur in Verbindung mit einem Clientcomputer (e-Filing Web-
Dienstprogramm) zur Verfügung. Zu den Einzelheiten dieser Funktionen siehe angegebene Referenzseiten.

Hinweis

Das e-Filing Web-Dienstprogramm unterstützt nur Windows. Mac OS und andere Betriebssysteme werden nicht 
unterstützt.

 Benutzerboxen/Ordner verwalten
Mit den folgenden Funktionen können Sie Benutzerboxen und Ordner in e-Filing verwalten.
 Benutzerboxen und Ordner erstellen
 S.39 “Benutzerboxen/Ordner erstellen”

 Benutzerboxen und Ordner löschen
 S.42 “Benutzerboxen und Ordner löschen”

 Benutzerboxen und Ordner bearbeiten (Name und Eigenschaften ändern)
 S.43 “Benutzerboxen und Ordner umbenennen”
 S.45 “Box- und Ordnereigenschaften anzeigen und ändern”

 Dokumente verwalten
Mit den folgenden Funktionen können Sie in e-Filing gespeicherte Dokumente verwalten.
 Dokumente als Miniaturbilder oder in Listenansicht anzeigen
 S.50 “Dokumente anzeigen”

 Dokumente umbenennen
 S.51 “Dokumente umbenennen”

 Dokumente löschen
 S.53 “Dokumente löschen”

 Dokumente drucken (gesamtes Dokument/Testdruck)
 S.54 “Dokumente drucken”

 Dokumente drucken und speichern
 S.59 “Dokumente mit dem Druckertreiber speichern”

 Dokumente archivieren
 S.63 “Dokumente archivieren”

 Dokumente als Email senden
 S.67 “Email Senden”

 Dokumente bearbeiten
Mit den folgenden Funktionen können Sie in e-Filing gespeicherte Dokumente bearbeiten.
 Dokument- und Seiteneigenschaften anzeigen
 S.77 “Dokument- und Seiteneigenschaften anzeigen”

 Seiten aus einem Dokument kopieren oder ausschneiden und in ein anderes Dokument einfügen
 S.78 “Seiten von einem Dokument in ein anderes kopieren”

 Seiten aus einem Dokument kopieren oder ausschneiden und als neues Dokument speichern
 S.83 “Seiten aus einem Dokument in eine Box oder einen Ordner kopieren”

 Seiten aus einem Dokument löschen
 S.86 “Seiten aus einem Dokument löschen”

 Leere Seiten in ein Dokument einfügen
 S.88 “Eine leere Seite in ein Dokument einfügen”

 Seiten innerhalb eines Dokuments verschieben, um ihre Reihenfolge zu ändern
 S.91 “Seiten innerhalb des Dokuments verschieben”

 Dokumente zwischen Boxen und Ordnern verschieben
 S.93 “Dokumente verschieben”

 Gesamtes Dokument kopieren und in ein anderes Dokument einfügen
 S.95 “Dokumente zusammenführen”
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Tipp

 Sie können e-Filing Dokumente mit dem TWAIN-Treiber oder Datei-Downloader in einen Clientcomputer 
importieren.

 Sie können Dokument in e-Filing und verschiedene e-Filing-Einstellungen mit dem Backup/Restore 
Dienstprogramm sichern und wieder herstellen.
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0.Dokumente drucken

Sie können in e-Filing gespeicherte Dokumente über den Touch Screen des Systems drucken.

Dokument vollständig drucken
Sie können das komplette Dokument ausdrucken.

1 Drücken Sie im Home-Bildschirm auf [e-Filing].

2 Wählen Sie die Box, die das zu druckende Dokument enthält.

Sie können die Boxnummer (3-stellig) auch eingeben.

 Kennworteingabe
Wenn für die Box ein Kennwort festgelegt ist, erscheint der Kennwort-Eingabebildschirm. Geben Sie das 
Kennwort ein und drücken Sie danach [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

3 Ist das Dokument in einem Ordner gespeichert, wählen Sie den Ordner und drücken [Öffnen 
(Open)].

Ist das Dokument nicht in einem Ordner gespeichert, ist dies nicht erforderlich.
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4 Wählen Sie das Dokument. Zum Ändern der Druckeinstellungen drücken Sie [Einstell. (Settings)]. 
Wenn Sie keine Änderungen vornehmen wollen, drücken Sie [Drucken (Print)].

Wenn Sie [Einstell. (Settings)] gedrückt haben, fahren Sie mit Schritt 5 fort.
Wenn Sie [Drucken (Print)] gedrückt haben, beginnt der Druckvorgang. Zum Löschen und Abbrechen des 
Druckvorgangs siehe nachfolgende Referenz:
 S.26 “Jobs abbrechen”

Tipp

Drücken Sie  , um Miniaturansichten der Dokumente anzuzeigen. Wählen Sie eines aus und drücken Sie 

[Öffnen (Open)], um den Inhalt zu sehen. Drücken Sie  , um zur Liste zurückzukehren.
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5 Ändern Sie die Druckeinstellungen nach Erfordernis.

Sie können die nachfolgenden Druckeinstellungen ändern. Führen Sie die entsprechenden Schritte aus. Die 
Bedienungsvorgänge sind identisch mit denen im Kopiermodus. Zu den Einzelheiten dieser Bedienungsvorgänge 
siehe nachfolgende Referenz:
Kopierfunktionen - KOPIERVORGANG
1. Wählen Sie die Papierquelle. Wenn die gewählte Papiergröße dem System nicht zur Verfügung steht, wird Ihre 

Einstellung zurückgesetzt und auf automatische Papierwahl umgeschaltet.
2. Geben Sie Anzahl der Ausfertigungen ein.
3. Wählen Sie den Duplexmodus. Wenn Sie nicht auf beiden Seiten des Papiers drucken möchten, wählen Sie 

[1 Seite (1 Side)].
4. Wählen Sie den Finishermodus. Die möglichen Einstellungen sind abhängig vom Modell und dem Typ des 

installierten Finishers.
5. Wählen Sie das Ausgabefach. Dies ist nur verfügbar, wenn der Finisher (optional) installiert ist. Diese Funktion 

ist für einige Modelle nicht verfügbar.
6. Stellen Sie die Position und Breite des Randes ein. Die einstellbaren Elemente sind je nach Modell verschieden.
7. Stellen Sie die Druckposition von Datum und Uhrzeit ein.
8. Stellen Sie die Druckposition von Seitenzahlen ein.

6 Drücken Sie [Drucken (Print)].

Zum Löschen und Abbrechen des Druckvorgangs siehe nachfolgende Referenz:
 S.26 “Jobs abbrechen”

1 6 7 8

3 4 5

2
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Testdruck
Sie können bestimmte Seiten eines Dokuments drucken.

1 Drücken Sie in der Startseite auf [e-Filing].

2 Wählen Sie die Box oder den Ordner, in dem das zu druckende Dokument enthalten ist.

Zur Auswahl der Box oder des Ordners siehe Beschreibung über das vollständige Drucken eines Dokuments. 
 S.14 “Dokument vollständig drucken”

3 Wählen Sie das zu druckende Dokument und drücken Sie [Testdruck (Test Print)].

Tipp

Drücken Sie  , um Miniaturansichten der Dokumente anzuzeigen. Wählen Sie eines aus und drücken Sie 

[Öffnen (Open)], um den Inhalt zu sehen. Drücken Sie  , um zur Liste zurückzukehren.
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4 Geben Sie die Seitennummern in [Erste Seite (First Page)] und [Letzte Seite (Last Page)] ein und 
drücken Sie auf [Drucken (Print)].

 Wenn Sie am Bedienfeld die Taste [Löschen (Clear)] drücken, können Sie den aktuell eingegebenen Wert 
löschen.

 Wenn Sie alle Seiten ausdrucken wollen, drücken Sie auf [Alle Seiten (All Pages)].
Zum Löschen und Abbrechen des Druckvorgangs siehe nachfolgende Referenz:
 S.26 “Jobs abbrechen”
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0.Dokumente speichern

Sie können Dokumente über den Touch Screen des Systems in e-Filing speichern.

Hinweis

 Verwenden Sie zum Speichern vertraulicher Dokumente die mit Kennwort geschützte Benutzerbox.
 Sie können bis zu bis zu 400 Dokumente pro Box oder Ordner und bis zu 200 Seiten pro Dokument speichern.
 Die maximale Kapazität des freigegebenen Ordners ist abhängig von Ihrem Modell und der Systemumgebung. Der 

verfügbare Speicherplatz für e-Filing und für den freigegebenen Ordner kann im Register [Gerät (Device)] von 
TopAccess geprüft werden.

 e-Filing sollte nicht als Permanentspeicher genutzt werden. Löschen Sie daher nicht mehr benötigte Dokumente. 
 S.27 “Dokumente löschen”

 Sie müssen die Größe folgender Originale manuell eingeben, da deren Größe vom System nicht korrekt ermittelt 
werden kann:
- Transparente Originale (z.B. Overheadfolien, Transparentpapier)
- Sehr dunkle Originale oder Originale mit dunklen Rändern
- Originale, die keinem Standardformat entsprechen (z.B. Zeitungen, Magazine)
Zu den Einzelheiten siehe nachfolgende Referenz. 
Vorbereitung der Papiermedien (e-STUDIO6525AC Serie/e-STUDIO6528A Serie) - ORIGINALE AUFLEGEN - 
Vorsichtsmaßnahmen für Originale
Vorbereitung der Papiermedien (e-STUDIO7527AC Serie/e-STUDIO9029A Serie) - ORIGINALE AUFLEGEN - 
Vorsichtsmaßnahmen für Originale

Tipp

 Um Dokumente in Benutzerboxen/Ordnern zu speichern, müssen Sie diese erzeugen.
 S.29 “Benutzerboxen erstellen”(Bedienung über das System)
 S.39 “Benutzerboxen/Ordner erstellen” (Bedienung über einen Clientcomputer)

 Sie können die Speicherdauer für Dokumente in den Box-Eigenschaften festlegen. Die Dokumente werden 
gelöscht, sobald die definierte Anzahl von Tagen verstrichen ist.
 S.45 “Box- und Ordnereigenschaften anzeigen und ändern” (Bedienung über einen Clientcomputer)

Kopieren und Speichern in e-Filing
Sie können Dokumente kopieren und gleichzeitig in e-Filing speichern. Die gespeicherten e-Filing Dokumente können 
anschließend wiederholt kopiert werden.

Hinweis

 Dokumente mit folgendem Papierformat können nicht in e-Filing gespeichert werden.
- Benutzerdefiniertes Papier
- Papier, das keinem Standardformat entspricht (Stapelblatteinzug)

 Ein Dokument, das mit der Funktion “Kopieren und Speichern in e-Filing” gespeichert wird, eignet sich zum 
Drucken, aber nicht für den Import in Ihren Computer. Um die beste Bildqualität für den Import eines Bildes auf 
Ihren Computer zu erhalten, speichern Sie das Dokument mit der Funktion “Scannen in e-Filing”.
 S.24 “Scannen in e-Filing” 

1 Legen Sie die Originale ein und wählen Sie den Kopiermodus.
Zu Einzelheiten über das Auflegen von Originalen und die Kopiereinstellungen siehe nachfolgende Referenz:
Vorbereitung der Papiermedien (e-STUDIO6525AC Serie/e-STUDIO6528A Serie) - ORIGINALE AUFLEGEN - 
Originale auflegen
Vorbereitung der Papiermedien (e-STUDIO7527AC Serie/e-STUDIO9029A Serie) - ORIGINALE AUFLEGEN - 
Originale auflegen
Kopierfunktionen - KOPIERVORGANG

Hinweis

Auch wenn für den Kopiermodus die Bildeinstellungen “Zweifarbige Kopie” oder “Monochrome Farbe” im 
Register [Bildqualität (Image)] getätigt sind, können Sie diese zum Speichern in e-Filing nicht benutzen. Dies gilt 
auch, wenn Sie Dokumente kopieren und gleichzeitig speichern.
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2 Drücken Sie im Kopierbildschirm auf [Speicher (Storage)].

3 Drücken Sie [Speich. In e-Filing (Store To e-Filing)].

4 Drücken Sie [Box/Ordner (Box/Folder)].
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5 Wählen Sie die Box, in der Sie das Dokument speichern wollen.

Sie können die Boxnummer (3-stellig) auch eingeben.

 Kennworteingabe
Wenn für die Box ein Kennwort festgelegt ist, erscheint der Kennwort-Eingabebildschirm. Geben Sie das 
Kennwort ein und drücken Sie danach [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

6 Drücken Sie [OK], um die Originale in der Box zu speichern.

 Speichern in einem Ordner
Wählen Sie den Ordner und drücken Sie [Öffnern (Open)]. Der Ordnerinhalt wird angezeigt. Drücken Sie [OK], 
um die Originale in diesem Ordner zu speichern.
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7 Ändern Sie gegebenenfalls den Dokumentnamen und drücken Sie [OK].

 Dokumente umbenennen
Geben Sie den Dokumentnamen (bis zu 64 Zeichen) in [Dokumentname (Document Name)] ein und drücken 
Sie danach [OK].

Tipp

 Standardmäßig wird eine Zeichenfolge bestehend aus “Doc”, Jahr, Monat und Datum angezeigt. Dieses 
Format kann in TopAccess geändert werden. Zu den Einzelheiten siehe nachfolgende Referenz: 
TopAccess - [Administration] - [Registration] ([Administration]) Elemente - Vorlage Einstellungen - Box 
Einstellungen 

 Wenn der gleiche Name bereits existiert, wird beim Speichern automatisch eine Laufnummer (-001, -002…) an 
das Ende des Dateinamens angehängt.

8 Drücken Sie [Ja (Yes)], um das Dokument zu speichern und zu drucken. Wenn Sie das Dokument 
ohne es zu drucken, speichern wollen, tippen Sie auf [Nein (No)]. 

9 Drücken Sie die Taste [START].
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Nächstes Original kopieren (Kopie)
Abhängig davon, wie die Originale eingelegt sind, erscheint ein Dialog zum Scannen des nächsten Originals. 
Wiederholen Sie die nachfolgenden Schritt nach Erfordernis. Wenn Sie mit dem Scannen der letzten Seite fertig 
sind, drücken Sie auf [Auftr. Ende (Job Finish)].
 Wird das Vorlagenglas verwendet, legen Sie das nächste Original auf und drücken [Nächste Kopie (Next Copy)], 

um es zu scannen.
 Wenn Sie den ADF oder SADF (Einzelblattmodus) verwenden, beginnt der Scanvorgang automatisch nach dem 

Einlegen des nächsten Originals. (Ohne dass Sie eine Taste betätigen.)
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Scannen in e-Filing
Sie können Dokumente kopieren und gleichzeitig in e-Filing speichern. Wenn Sie das Bild in einen Clientcomputer 
importieren möchten, empfehlen wir das Dokument mit Scan to e-Filing zu speichern.

1 Positionieren Sie das zu speichernde Dokument und tätigen Sie die erforderlichen 
Scaneinstellungen. 
Zu Einzelheiten über das Auflegen von Originalen und die Scaneinstellungen siehe nachfolgende Referenzen:
Vorbereitung der Papiermedien (e-STUDIO6525AC Serie/e-STUDIO6528A Serie) - ORIGINALE AUFLEGEN - 
Originale auflegen
Vorbereitung der Papiermedien (e-STUDIO7527AC Serie/e-STUDIO9029A Serie) - ORIGINALE AUFLEGEN - 
Originale auflegen
Scanfunktionen - NÜTZLICHE FUNKTIONEN - Scan Einstellungen ändern

2 Drücken Sie [e-Filing].

3 Wählen Sie die Box oder den Ordner, in dem Sie das Dokument speichern wollen. Ändern Sie 
gegebenenfalls den Dokumentnamen und drücken Sie [OK].

Zur Auswahl der Box oder des Ordners und zur Namensänderung gehen Sie so vor, wie es unter Kopieren und 
Speichern in e-Filing beschrieben ist. 
 S.19 “Kopieren und Speichern in e-Filing”

4 Drücken Sie [Scannen (Scan)].
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Hinweis

Die Anzahl der akzeptierten Scanjobs ist abhängig von den Scan-Einstellungen. Wenn Sie die maximale Anzahl 
für Scan-Aufträge überschreiten, erhalten Sie die Meldung, dass die Kapazitätsgrenze erreicht ist. Warten Sie bis 
die Scanjobs abgearbeitet sind oder löschen Sie nicht benötigte Scan-Reservierungen (Scanjobs).
 S.26 “Druckjobs löschen”

Nächstes Original scannen (Scan)
 Wenn Sie über das Vorlagenglas scannen oder über den ADF scannen und [Weiter (Continue)] drücken, 

erscheint ein Dialog zum Scannen des nächsten Originals.
 Drücken Sie in beiden Fällen auf [Scannen (Scan)], um das Original zu scannen. Wiederholen Sie die 

nachfolgenden Schritt nach Erfordernis. Wenn Sie mit dem Scannen der letzten Seite fertig sind, drücken Sie 
auf [Auftr. Ende (Job Finish)].

 Drücken Sie [Scan Einst. (Scan Setting)], um die Scan-Einstellungen zu ändern.
 Drücken Sie [Auftr. Abbr. (Job Cancel)], um den reservierten Scan-Auftrag abzubrechen.
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0.Jobs abbrechen

Aktive Jobs abbrechen
Drücken Sie [Stopp (Stop)], wenn Sie einen laufenden Druck- oder Scanvorgang abbrechen wollen.

Druckjobs löschen
Führen Sie folgende Schritte aus, um den Druck- oder Scanvorgang eines Dokuments zu stoppen (Druckjob löschen).

1 Drücken Sie [Job Status].

2 Wählen Sie im Menü die Anzeige der Jobliste.

3 Wählen Sie den zu löschenden Job und drücken Sie danach [Löschen (Delete)].

4 Das Bestätigungs-Dialogfeld erscheint. Drücken Sie [Löschen (Delete)].
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0.Dokumente löschen

Sie können Dokumente in e-Filing über den Touch Screen des Systems löschen.

Hinweis

e-Filing sollte nicht als Permanentspeicher genutzt werden. Löschen Sie daher nicht mehr benötigte Dokumente. 

Tipp
Wenn Sie einen Ordner oder eine Box löschen, sind auch alle darin enthaltenen Dokumente gelöscht.
 S.31 “Benutzerboxen/Ordner löschen”(Bedienung über das System)
 S.42 “Benutzerboxen und Ordner löschen” (Bedienung über einen Clientcomputer)

1 Drücken Sie in der Startseite auf [e-Filing].

2 Wählen Sie die Box oder den Ordner, in dem das zu löschende Dokument enthalten ist.

Zur Auswahl der Box oder des Ordners siehe Beschreibung über das vollständige Drucken eines Dokuments.
 S.14 “Dokument vollständig drucken”

3 Wählen Sie das Dokument, das Sie löschen wollen, und drücken Sie [Löschen (Delete)].

Tipp

Drücken Sie  , um Miniaturansichten der Dokumente anzuzeigen. Wählen Sie eines aus und drücken Sie 

[Öffnen (Open)], um den Inhalt zu sehen. Drücken Sie  , um zur Liste zurückzukehren.
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4 Drücken Sie [Löschen (Delete)], um das ausgewählte Dokument zu löschen.

Drücken Sie [Abbrechen (Cancel)], um das Löschen des Dokuments abzubrechen.
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0.Benutzerboxen/Ordner verwalten

Sie können Benutzerboxen und Ordner über den Touch Screen des Systems verwalten.

Tipp
Ordner können nur mit einem Clientcomputer erstellt und bearbeitet werden.
 S.39 “Benutzerboxen/Ordner erstellen”
 S.43 “Benutzerboxen und Ordner umbenennen”
 S.45 “Box- und Ordnereigenschaften anzeigen und ändern”

Benutzerboxen erstellen
Sie können bis zu 200 Benutzerboxen erstellen.

1 Drücken Sie in der Startseite auf [e-Filing].

2 Drücken Sie das Register [Box-Einstell (Box Setting)], wählen Sie eine der nummerierten Tasten 
von “001” bis “200” und drücken Sie [Setup].

Sie können die Boxnummer (3-stellig) auch direkt eingeben.

3 Geben Sie Boxname und Kennwort in [Box-Name (Box Name)], [Kennwort (Password)] und 
[Kennwort Wdhl (Retype Password)] ein und drücken Sie danach [OK].

 Boxname eingeben
Geben Sie den Boxnamen (bis zu 32 Zeichen) in [Box-Name (Box Name)] ein und drücken Sie danach [OK]. Die 
folgenden 1-Byte-Zeichen können nicht benutzt werden.
" # % & ' = | { } * < > ? [ ] ; : / \ ,
Verwenden Sie keine Leerstelle oder einen Punkt am Anfang oder am Ende des Namens. Wenn Sie diese 
Zeichen eingeben wird eine Fehlermeldung angezeigt.

 Kennwort eingeben
Die Benutzerbox kann ohne Kennwort erstellt werden. Wenn Sie ohne Kennworteingabe [OK] drücken, wird 
eine Benutzerbox erstellt, auf die alle Benutzer, wie bei der öffentlichen Box, zugreifen können.
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Hinweis

Wenn das eingegebene Kennwort nicht der Kennwort-Richtlinie entspricht, erscheint eine Warnmeldung. Geben 
Sie das korrekte Kennwort ein.
Zu den Einzelheiten der Kennwortrichtlinie siehe nachfolgende Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Kennwortrichtlinie Einstellung - Richtlinie 
für e-Filing Boxen, SicheresPDF, SNMPv3, Klonen und sicheren Empfang festlegen

Benutzerboxen bearbeiten
Der registrierte Boxname und das Kennwort der Benutzerbox können geändert werden.

1 Drücken Sie in der Startseite auf [e-Filing].

2 Drücken Sie das Register [Box-Einstell (Box Setting)], wählen Sie die gewünschte Benutzerbox 
und drücken Sie [Bearbeiten (Edit)].

Sie können die Boxnummer (3-stellig) auch direkt eingeben.

 Kennworteingabe
Wenn für die Box ein Kennwort festgelegt ist, erscheint der Kennwort-Eingabebildschirm. Geben Sie das 
Kennwort ein und drücken Sie danach [OK].

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Ändern Sie nach Erfordernis [Box-Name (Box Name)] / [Kennwort (Password)] / [Kennwort Wdhl 
(Retype Password)] und drücken Sie [OK].

Zur Änderung von [Box-Name (Box Name)] / [Kennwort (Password)] / [Kennwort Wdhl (Retype Password)] siehe 
Beschreibung über das Erstellen von Benutzerboxen.
 S.29 “Benutzerboxen erstellen”
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Benutzerboxen/Ordner löschen
Sie können Benutzerboxen und Ordner löschen.

Hinweis

Wenn Sie einen Ordner oder eine Box löschen, sind auch alle darin enthaltenen Unterordner und Dokumente 
gelöscht.

1 Drücken Sie in der Startseite auf [e-Filing].

2 Führen Sie die nachfolgenden Schritte aus.
 Benutzerboxen löschen

Drücken Sie das Register [Box Einstellung (Box Setting)], wählen Sie die gewünschte Benutzerbox und drücken 
Sie [Löschen (Delete)].

Zur Auswahl der Box oder des Ordners gehen Sie so vor, wie es für die Bearbeitung von Benutzerboxen 
beschrieben ist.  
 S.30 “Benutzerboxen bearbeiten”

 Ordner löschen
Drücken Sie das Register [Drucken (Print)], wählen Sie den gewünschten Ordner und drücken Sie [Löschen 
(Delete)].

Zur Auswahl von Ordnern siehe Beschreibung über das vollständige Drucken eines Dokuments.
 S.14 “Dokument vollständig drucken”
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3 Drücken Sie [Löschen (Delete)], um die ausgewählte Box/den Ordner zu löschen.

Drücken Sie [Abbrechen (Cancel)], um das Löschen der Box/des Ordners abzubrechen.
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0.Bevor Sie das e-Filing Dienstprogramm benutzen

Bitte prüfen Sie die folgenden Punkte auf Ihrem Computer, bevor Sie das e-Filing Dienstprogramm benutzen.

Hinweis

Das e-Filing Web-Dienstprogramm unterstützt nur Windows-Computer. Sie können es nicht mit Computern unter Mac 
oder anderen Betriebssystemen benutzen.

Unterstützte Web Browser
Das e-Filing Dienstprogramm kann mit den folgenden Browsern für Microsoft-Betriebssysteme verwendet werden:
 Microsoft Edge 89 oder höher
 Firefox 86 oder höher
 Chrome 89 oder höher
 Die minimale erforderliche Bildschirmauflösung für diese Browser beträgt 800 x 600 Punkte.
 Deaktivieren Sie den Popup-Blocker im Web Browser. Einzelheiten hierzu finden Sie in der Online-Hilfe des Web 

Browsers, den Sie benutzen.
 Setzen Sie unter Microsoft Edge die Einstellung [Popups blockieren (Block pop-ups)] auf [Aus (Off)]. Setzen Sie 

zusätzlich die Einstellung für Cookies auf [Keine Cookies blockieren (Don't block cookies)]. Zu Hinweisen über die 
Einstellungen von Microsoft Edge siehe nachfolgende Referenz:
 S.34 “Microsoft Edge Einstellung”

Microsoft Edge Einstellung
Wenn Sie Microsoft Edge nutzen, stellen Sie [Popups blockieren (Block pop-ups)] und [Cookies] so ein, dass sie nicht 
blockiert werden. 
Zu den Einzelheiten dieser Einstellung siehe Microsoft-Webseite.
Wenn die Einstellung abgeschlossen ist, beenden Sie Microsoft Edge und starten es neu, um auf das e-Filing 
Dienstprogramm zuzugreifen.
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0.e-Filing Dienstprogramm starten

Dieser Abschnitt erläutert, wie Sie das e-Filing Dienstprogramm starten und beenden. Der Startvorgang des 
Dienstprogramms ist davon abhängig, ob Sie als Benutzer oder Administrator angemeldet sind.

Als Benutzer anmelden
Es gibt zwei Arten, das e-Filing Dienstprogramm aufzurufen:
 Klicken Sie in der TopAccess-Webseite auf den Link für das e-Filing Dienstprogramm.
 Geben Sie die URL des e-Filing Dienstprogramms in das Adressenfeld Ihres Webbrowsers ein.
Die URL lautet: http://[IP-Adresse]/?MAIN=EFILING
Der Abschnitt [IP-Adresse (IP address)] entspricht der IP-Adresse dieses Systems. Sie können anstelle der IP-Adresse 
den DNS-Namen dieses Systems verwenden.
Beispiel: Die IP-Adresse des Systems ist 192.168.1.2
 http://192.168.1.2/?MAIN=EFILING
Beispiel: Der DNS-Name dieses Systems ist mfp-00000236
 http://mfp-00000236/?MAIN=EFILING

Tipp

 Nach Start des e-Filing Dienstprogramms kann es von den Anwendern benutzt werden.
 Der Zugriff auf das e-Filing Web-Dienstprogramm kann zeitlich begrenzt werden, wenn dies unter Zeitlimit für 

Sitzung in [Allgemeine WEB-Einstellungen (WEB General Setting)] von TopAccess festgelegt ist.
 Um die Administratorfunktionen des Dienstprogramms zu nutzen, müssen Sie sich als Systemadministrator 

anmelden, nachdem Sie darauf zugegriffen haben.
 S.100 “Als Systemadministrator anmelden”

Über die Benutzerverwaltung
Ist die Benutzerverwaltung aktiviert, wird nach Eingabe der URL für das e-Filing Dienstprogramm der 
Anmeldebildschirm angezeigt. Geben Sie in diesem Fall den Benutzernamen und das Kennwort ein, um sich auf 
der Hauptseite des e-Filing Dienstprogramms anzumelden.

Hinweis

 Je nach Modell und Auslieferungsland müssen Sie das Standard-Administratorkennwort für die erste 
Anmeldung ändern. Zu den Einzelheiten siehe nachfolgende Referenz: 
TopAccess - Übersicht - Berechtigungsbasierter Modus
 Wenn Sie bei der Systemanmeldung mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 

definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird.
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0.Menüs im e-Filing Dienstprogramm 

Oben rechts im Browser-Fenster des e-Filing Dienstprogramms befinden sich drei Hauptregister: [Dokumente 
(Documents)], [Einstellungen (Preferences)] und [Administration].

[Dokumente (Documents)]
Das Register [Dokumente (Documents)] ist die Standardseite und steht allen Benutzern zur Verfügung. Es enthält die 
Fenster der Ordner und Dokumente und die Menüleiste mit weiteren Funktionen.

1. Dokumentfenster
Das Dokumentfenster ist ein dem Windows Explorer nachempfundener Anzeigebereich. In diesem Fenster 
können Sie Zielordner und Dokumente auswählen.
Im Dokumentbereich werden je nach Kontext folgende Symbole angezeigt:
- Boxsymbole

 : Dieses Symbol bezeichnet eine geschlossene Box.

 : Dieses Symbol bezeichnet eine offene Box.

 : Dieses Symbol bezeichnet eine geschlossene Box, die durch ein Kennwort geschützt ist.

 : Dieses Symbol bezeichnet eine geöffnete Box, die durch ein Kennwort geschützt ist.
- Ordnersymbole

 : Dieses Symbol bezeichnet einen geschlossenen Ordner.

 : Dieses Symbol bezeichnet einen geöffneten Ordner.
- Dokumentsymbole

   : Dieses Symbol bezeichnet ein Dokument, das bei einem Druckvorgang gespeichert wurde. Wenn 
dieses Symbol auf weißem Hintergrund angezeigt wird, ist das Dokument derzeit im Ansichtsmodus. Wenn 
dieses Symbol auf blauem Hintergrund angezeigt wird, ist das Dokument derzeit im Bearbeitungsmodus.

   : Dieses Symbol bezeichnet ein Dokument, das bei einem Scanvorgang gespeichert wurde. Wenn 
dieses Symbol auf weißem Hintergrund angezeigt wird, ist das Dokument derzeit im Ansichtsmodus. Wenn 
dieses Symbol auf blauem Hintergrund angezeigt wird, ist das Dokument derzeit im Bearbeitungsmodus.

4
1

2 3

5
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   : Dieses Symbol bezeichnet ein Dokument, das bei einem Kopiervorgang gespeichert wurde. Wenn 
dieses Symbol auf weißem Hintergrund angezeigt wird, ist das Dokument derzeit im Ansichtsmodus. Wenn 
dieses Symbol auf blauem Hintergrund angezeigt wird, ist das Dokument derzeit im Bearbeitungsmodus.

   : Dieses Symbol bezeichnet ein Dokument, das bei einem Faxvorgang mit der Mailboxfunktion, der 
Funktion Empfangenes Fax weiterleiten oder der Funktion Empfangenes Internet-Fax weiterleiten gespeichert 
wurde.
Wenn dieses Symbol auf weißem Hintergrund angezeigt wird, ist das Dokument derzeit im Ansichtsmodus. 
Wenn dieses Symbol auf blauem Hintergrund angezeigt wird, ist das Dokument derzeit im 
Bearbeitungsmodus.

  : Dieses Symbol bezeichnet ein Dokument, das durch Zusammenführung mehrerer Dokumente 
erzeugt wurde. Wenn dieses Symbol auf weißem Hintergrund angezeigt wird, ist das Dokument derzeit im 
Ansichtsmodus. Wenn dieses Symbol auf blauem Hintergrund angezeigt wird, ist das Dokument derzeit im 
Bearbeitungsmodus.

2. Menüleiste
Sie können e-Filing Funktionen über die Menüleiste ausführen. In der Menüleiste werden die folgenden vier 
Menüs angezeigt: Datei, Bearbeiten, Ansicht und Layout.

3. Symbolleiste
In der Symbolleiste werden Symbole für die folgenden Funktionen angezeigt: Senden, Email, Speichern, 
Testdruck, Ausschneiden, Kopieren, Einfügen, Beginn, Zurück, Weiter und Ende. Über diese Schaltflächen 
erhalten Sie mit einem Klick Zugriff auf die gewünschten Funktionen.

: Klicken Sie auf diese Taste, um die markierten Dokumente als Email zu senden.

: Klicken Sie auf dieses Symbol, um das Dokument zu speichern. Dis ist nur möglich, wenn Sie das Dokument 
im Bearbeitungsmodus anzeigen.

: Klicken Sie auf diese Taste, um einen Testdruck durchzuführen.

: Klicken Sie auf dieses Symbol, um die markierten Dokumente oder Seiten auszuschneiden.

: Klicken Sie auf dieses Symbol, um die markierten Dokumente oder Seiten zu kopieren.

: Klicken Sie auf dieses Symbol, um die kopierten Elemente einzufügen.

: Klicken Sie auf dieses Symbol, um die ersten Elemente im Fensterausschnitt anzuzeigen.

: Klicken Sie auf dieses Symbol, um die vorherige Gruppe von Elementen im Fensterausschnitt anzuzeigen.

: Klicken Sie auf dieses Symbol, um die nachfolgenden Elemente im Fensterausschnitt anzuzeigen.

: Klicken Sie auf dieses Symbol, um die letzten Elemente im Fensterausschnitt anzuzeigen.

4. Inhaltfenster
Das Inhaltfenster zeigt die Dokumente oder Seiten an, die Sie aktuell bearbeiten. In diesem Fenster können Sie 
den Status eines Dokuments ändern und Ihre Dokumente drucken und bearbeiten. Während der Arbeit mit dem 
Dokument werden die Kontrolltasten und der Dokumentstatus angezeigt.

Tipp
Zu Einzelheiten über die Dokument-Kontrolltasten siehe nachfolgende Referenz:
 S.76 “Dokumentseiten bearbeiten”

5. Hilfe
Klicken Sie darauf, um die Onlinehilfe anzuzeigen.
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[Einstellungen (Preferences)]
Das Register [Einstellungen (Preferences)] ist für alle Benutzer zugänglich. Hierüber können Sie die Dokumentansicht 
einstellen und die Anzahl der am Bildschirm angezeigten Miniaturansichten festlegen.

1. Dokument Standardansicht
Sie können entweder Miniaturansicht oder Listenansicht auswählen. Das System zeigt Ihre Dokumente in der 
gewählten Ansicht an, bis Sie eine andere Option im Ansichtsmenü auswählen. Standard ist die Miniaturansicht.

2. Miniaturen [Anzahl (number)] pro Ansicht laden.
Benutzen Sie die Dropdownliste, um die Anzahl der Miniaturansichten auszuwählen, zum Beispiel 4, 8 oder 12. 
Der Standardwert ist 8.

3. Fortschrittsbalken anzeigen.
Markieren Sie dies, um beim Kopieren, Ausschneiden, Einfügen von Dokumenten oder Seiten, Löschen von 
Seiten und Speichern von Dokumenten einen Fortschrittsbalken anzuzeigen.

4. [Speichern (Save)]
Klicken Sie auf diese Schaltfläche, um Ihre neuen Einstellungen zu übernehmen.

5. [Zurücksetzen (Reset)]
Klicken Sie auf diese Option, um die Standardeinstellungen wiederherzustellen.

Anmelden (Log-in)
Verwenden Sie den Link neben den Hauptregistern, um sich als Systemadministrator anmelden.
 S.100 “Als Systemadministrator anmelden”
Sie können die administrativen Funktionen im Register [Administration] aufrufen, nachdem Sie sich als 
Systemadministrator angemeldet haben.

1
2
3

4
5
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0.Benutzerboxen/Ordner verwalten

Das e-Filing-Dienstprogramm bietet zwei Arten von Boxen an: Öffentliche Box und Benutzerbox. Jeder Anwender 
kann eigene Benutzerboxen und darin, in der ersten Ebene, Ordner erzeugen.

Tipp
Einzelheiten zur öffentlichen Box und Benutzerbox siehe nachfolgende Referenz:
 S.8 “e-Filing Merkmale”

Benutzerboxen/Ordner erstellen
Jeder Anwender kann eigene Benutzerboxen erstellen und diese nach Wunsch mit einem Kennwort schützen.

 Benutzerboxen erstellen
Sie können bis zu 200 dieser Boxen erstellen und jede mit einem Kennwort schützen.

Tipp
Sie können Benutzerboxen auch über den Touch Screen erstellen. Einzelheiten zum Erstellen von Benutzerboxen 
über den Touch Screen siehe nachfolgende Referenz:
 S.29 “Benutzerboxen erstellen”

1 Wählen Sie “e-Filing” im Register [Dokumente (Documents)] und wählen Sie dann die Position 
[Neue Box (New Box)] im Menü [Datei (File)].

Das Fenster Neue Box wird angezeigt.

2 Definieren Sie die Boxeigenschaften und schließen Sie den Vorgang ab.
 [Box-Nummer (Box Number)]: Zur Auswahl der Boxnummer.

Eine bereits existierende Boxnummer kann nicht ausgewählt werden. In der Auswahl-Liste erscheinen nur die 
noch nicht zugeteilten Boxnummern.

 [Box-Name]: Zur Eingabe des Boxnamens.
Box-Namen bestehen aus dem ASCII-Zeichensatz, mit folgenden Ausnahmen:
\ / < > " % & = ' ; : * ? | # [ ] { }. 
Verwenden Sie keine Leerstelle oder einen Punkt am Anfang oder am Ende des Namens. Die maximale Länge 
für einen Boxnamen beträgt 32 Zeichen.
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 [Box-Kennwort (Box Password)] / [Kennwort bestätigen (Retype Password)]: Geben Sie ein Kennwort ein, 
wenn Sie die Box durch ein Kennwort schützen wollen.

Die erstellte Benutzerbox erscheint im Dokumentfenster.

Tipp
Die Anwender können erweiterte Einstellungen für jede Box vornehmen, wie beispielsweise die Verweildauer von 
Dokumenten in der Box und Email-Benachrichtigungsfunktionen.
 S.45 “Box-Eigenschaften ändern”

 Ordner erstellen
Sie können bis zu 100 Ordner in jeder Box erstellen.

Hinweis

Es können nur Ordner der ersten Ebenen erstellt werden. Sie können daher keine Unterordner in den Ordnern 
erstellen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box, in 
der Sie den Ordner erstellen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.
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3 Wählen Sie [Datei (File)] > [Neuer Ordner (New Folder)].

Das Fenster Neuer Ordner wird angezeigt.

4 Geben Sie den Ordnernamen ein und klicken Sie auf [OK].

Der erstellte Ordner erscheint unter der markierten Box im Dokumentfenster.

Hinweis

Ordnernamen bestehen aus dem ASCII-Zeichensatz, außer:
\ / < > " % & = ' ; : * ? | # [ ] { }. 
Verwenden Sie keine Leerstelle oder einen Punkt am Anfang oder am Ende des Namens. Die maximale Länge für 
einen Ordnernamen beträgt 64 Zeichen.
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Benutzerboxen und Ordner löschen
Mit folgenden Schritten können Sie Benutzerboxen und Ordner löschen.

Hinweis

 Es können nur die Ordner in der öffentlichen Box und nicht die Box selbst gelöscht werden.
 Wenn Sie einen Ordner oder eine Box löschen, sind auch alle darin enthaltenen Dokumente und Unterordner 

gelöscht.

Tipp

 Wenn die Box mit einem Kennwort geschützt ist, müssen Sie das Kennwort eingeben, bevor Sie die Box und die 
Ordner löschen können. Administratoren können nach Eingabe des Administratorkennworts alle Benutzerboxen 
und Ordner löschen.

 Sie können Benutzerboxen auch über den Touch Screen löschen. Einzelheiten zum Löschen von Benutzerboxen 
über den Touch Screen siehe nachfolgende Referenz:
 S.31 “Benutzerboxen/Ordner löschen”

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box, in 
der Sie den Ordner löschen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Zum Löschen einer Benutzerbox, wählen Sie [Bearbeiten (Edit)] > [Löschen (Delete)]. Zum 
Löschen von Ordnern markieren Sie die Kontrollkästchen der zu löschenden Ordner und wählen 
[Bearbeiten (Edit)] > [Löschen (Delete)].

Das Dialogfeld mit einer Bestätigungsaufforderung wird angezeigt.
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Hinweis

Sie können einen Ordner auch im Dokumentfenster markieren und über [Bearbeiten (Edit)] > [Löschen (Delete)] 
entfernen. In diesem Fall sollten Sie sicherstellen, dass keine Dokumente im Inhaltsabschnitt markiert sind. 
Sollten Dokumente markiert sein, werden diese anstelle des markierten Ordners gelöscht.

4 Klicken Sie auf [OK].

Die ausgewählten Ordner werden gelöscht.

Benutzerboxen und Ordner umbenennen
Mit folgenden Schritten können Sie Benutzerboxen und Ordner umbenennen.

Hinweis

 Es können nur die Ordner in der öffentlichen Box und nicht die Box selbst umbenannt werden.
 Schalten Sie das System beim Ändern des Box- oder Ordnernamens nicht aus. Alle Ordner und Dokumente in der 

Box gehen verloren, wenn der Strom ausgeschaltet wird, während das System einen neuen Namen speichert.

Tipp

 Wenn die Box mit einem Kennwort geschützt ist, muss der Benutzer das Kennwort eingeben, bevor die Box oder 
der Ordner umbenannt werden kann. Administratoren können nach Eingabe des Administratorkennworts alle 
Benutzerboxen und Ordner umbenennen.

 Sie können Benutzerboxen auch über das Bedienfeld umbenennen.
Einzelheiten zum Umbenennen von Benutzerboxen über das Bedienfeld siehe nachfolgende Referenz:
 S.30 “Benutzerboxen bearbeiten”

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box, die 
Sie umbenennen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.
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3 Zum Umbenennen einer Benutzerbox, wählen Sie [Datei (File)] > [Umbenennen (Rename)]. Zum 
Umbenennen eines Ordners markieren Sie das Kontrollkästchen des Ordners und wählen [Datei 
(File)] > [Umbenennen (Rename)].

Das Fenster Box umbenennen wird angezeigt.

Hinweis

 Markieren Sie nicht mehrere Ordner gleichzeitig. Sie können nur jeweils einen Ordner umbenennen.
 Sie können den Namen eines Ordners nach dem Markieren im Dokumentfenster auch über das Menü 

[Bearbeiten (Edit)] und die Option [Umbenennen (Rename)] ändern. In diesem Fall sollten Sie sicherstellen, 
dass keine Dokumente im Inhaltsfenster markiert sind. Sollten ein Dokument markiert sein, wird dieses 
Dokument anstelle des Ordners umbenannt.

4 Bearbeiten Sie den Namen und klicken Sie auf [OK].

Das Bestätigungs-Dialogfeld erscheint.

Hinweis

Box-Namen bestehen aus dem ASCII-Zeichensatz, mit folgenden Ausnahmen:
\ / < > " % & = ' ; : * ? | # [ ] { }. 
Verwenden Sie keine Leerstelle oder einen Punkt am Anfang oder am Ende des Namens. Die maximale Größe 
beträgt für den Boxnamen 32 Zeichen und für den Ordnernamen 64 Zeichen.

5 Klicken Sie auf [OK].

Die ausgewählte Box wird umbenannt.
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Box- und Ordnereigenschaften anzeigen und ändern
Sie können die Eigenschaften der Benutzerboxen ansehen und ändern, wie beispielsweise das Box-Kennwort, das 
Intervall für die automatische Löschung von Dokumenten und die eingestellte Email-Benachrichtigung. Mit folgenden 
Schritten können Sie die Ordnereigenschaften prüfen.

Tipp
Wenn die Box mit einem Kennwort geschützt ist, müssen Sie das Kennwort eingeben, bevor Sie die Box-Eigenschaften 
ändern können. Administratoren können nach Eingabe des Administratorkennworts alle Eigenschaften von 
öffentlichen und privaten Benutzerboxen ändern.

 Box-Eigenschaften ändern

Hinweis

 Wenn Sie die Eigenschaften der öffentlichen Box ändern möchten, müssen Sie sich zuerst als Systemadministrator 
anmelden.

 Sie können das Kennwort einer Box nicht ändern, wenn gerade auf sie zugegriffen wird.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box, 
deren Eigenschaften Sie anzeigen und ändern wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie [Datei (File)] > [Eigenschaften (Properties)].

Das Fenster Box-Eigenschaften wird angezeigt.
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4 Wenn Sie die Box-Eigenschaften ändern möchten, klicken Sie auf [Eigenschaften ändern (Change 
Properties)].

Das Fenster Box-Eigenschaften ändern wird angezeigt.

Tipp
Wenn Sie keine Änderungen vornehmen wollen, drücken Sie [OK], um den Vorgang zu beenden.

5 Definieren Sie ggf. folgende Positionen und drücken Sie [Speichern (Save)].

 Box-Kennwort ändern — Markieren Sie dies, um das Kennwort der Box zu bearbeiten.
- Altes Kennwort — Geben Sie das aktuelle Box-Kennwort ein.

- Neues Kennwort — Geben Sie das neue Kennwort ein.

- Neues Kennwort bestätigen — Geben Sie das neue Box-Kennwort erneut ein.

 Dokument automatisch löschen — Wählen Sie diese Option, um Dokumente in dieser Box automatisch zu 
löschen.

 Aufbewahrungszeit für Dokumente — Geben Sie die Aufbewahrungszeit der Dokumente in Tagen ein. Die 
Dokumente werden gelöscht, sobald die Frist verstrichen ist. Wenn Sie 1 eingeben, wird das Dokument 
automatisch nach 24 Stunden gelöscht.

 Email bei Fehler senden — Markieren Sie dies, wenn Sie bei auftretenden Fehlern eine Benachrichtigung per 
Email erhalten wollen. Geben Sie anschließend eine Email-Adresse in das Feld [Email-Adresse (Email Address)] 
ein.

 Email nach erledigtem Job senden — Markieren Sie dies, wenn Sie nach jedem erledigtem Job eine 
Benachrichtigung per Email erhalten wollen. Geben Sie anschließend eine Email-Adresse in das Feld [Email-
Adresse (Email Address)] ein.

 Automatische Löschbenachrichtigung — Markieren Sie dies, um die Email-Benachrichtigung zu aktivieren. 
Drei Tage vor dem automatischen Löschen der Dokumente wird dann eine Benachrichtigung an die 
angegebene Email-Adresse gesendet. Geben Sie anschließend eine Email-Adresse in das Feld [Email-Adresse 
(Email Address)] ein.
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- Email Adresse — Geben Sie die Email-Adresse ein, an welche die Benachrichtigung gesendet werden soll. 
Dieses Kontrollkästchen ist aktiviert, wenn das Kontrollkästchen [Dokument automatisch Löschen (Delete 
document automatically)] markiert ist.

Hinweis

Wenn ein Dokument automatisch nach Ablauf der Aufbewahrungszeit gelöscht wurde, wird dies nicht in 
Ereignisprotokollen festgehalten. Zu den Einzelheiten über Protokolle siehe nachfolgende Referenz:
TopAccess - [Protokolle (Logs)]

Tipp

 Wenn Sie das alte Kennwort vergessen haben, können Sie stattdessen das Administratorkennwort in das Feld 
[Altes Kennwort (Old Password)] eingeben.

 Wenn Sie das automatische Senden von Emails nach einem Job und nach einem Fehler aktivieren, werden Sie 
über folgende Ereignisse benachrichtigt.
- Scannen in e-Filing
- Kopieren in e-Filing
- Drucken in e-Filing
- Empfangenes Fax/Internet Fax weiterleiten in e-Filing
- e-Filing to Print
- e-Filing to Email

Der Administrator kann die e-Filing-Benachrichtigung konfigurieren unter TopAccess [Administration] > Wartung 
> Benachrichtigung einstellen. Zu den Einzelheiten siehe nachfolgende Referenz: 
TopAccess - [Administration] - [Wartung (Maintenance)] Elemente - Benachrichtigung Einstellungen - 
Benachrichtigung für Systemereignisse

6 Klicken Sie auf [OK], um das Fenster Box-Eigenschaften zu schließen.



3.BEDIENUNG ÜBER EINEN CLIENTCOMPUTER

48    Benutzerboxen/Ordner verwalten

 Ordnereigenschaften anzeigen
Sie können die Ordnereigenschaften nur prüfen. Das Ändern der Ordnereigenschaften ist nicht möglich.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box die 
den Ordner enthält, dessen Eigenschaften Sie anzeigen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie das Kontrollkästchen des Ordners, dessen Eigenschaften Sie betrachten wollen, 
und wählen Sie [Datei (File)] > [Eigenschaften (Properties)].

Das Fenster Ordnereigenschaften wird angezeigt. In diesem Fenster können Sie die Ordnereigenschaften 
betrachten.

Hinweis

 Markieren Sie nicht mehrere Ordner gleichzeitig. Sie können nur die Eigenschaften für einen Ordner 
betrachten.

 Anwender können die Eigenschaften eines Ordners nach dem Markieren im Dokumentfenster auch über das 
Menü [Datei (File)] und die Option [Eigenschaften (Properties)] anzeigen lassen. In diesem Fall sollten Sie 
sicherstellen, dass keine Dokumente im Inhaltsfenster markiert sind. Sollten ein Dokument markiert sein, 
werden die Eigenschaften dieses Dokuments anstelle des Ordners angezeigt.
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4 Klicken Sie auf [OK], um das Fenster Ordnereigenschaften zu schließen.

Folgende Informationen werden angezeigt:
 Standort — Zeigt das Verzeichnis an, in dem sich der Ordner befindet.

 Enthält — Zeigt die Anzahl der Dateien an, die im Ordner enthalten sind.

 Erstellt — Zeigt das Datum und die Uhrzeit für die Erstellung des Ordners an.

 Modifiziert — Zeigt Datum und Uhrzeit der letzten Änderung.
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0.Dokumente verwalten

Mit dem e-Filing Dienstprogramm können Sie in e-Filing gespeicherte Dokumente verwalten.

Dokumente anzeigen
Sie können Ihre Dokumentdateien auf zwei Arten anzeigen. Die Optionen für die Anzeige sind:
 Miniaturansicht

Die Miniaturansicht zeigt mehrere Dateien in der ausgewählten Box bzw. im Ordner an, oder mehrere Seiten des 
ausgewählten Dokuments. Das ist die Standardansicht. Mit ihr können Sie Dokumente und Dateien verwalten.
 S.50 “Miniaturansicht verwenden”

 Liste
Die Listenansicht zeigt Dateinamen und Eigenschaften in einem Tabellenformat an. Damit können Sie Boxen und 
Ordner, die eine große Anzahl von Dateien enthalten, einfach verwalten.
 S.51 “Listenansicht verwenden”

 Miniaturansicht verwenden
Dies ist die Standardansicht, wenn Sie keine andere Einstellung für die Ansicht festlegen. Sie zeigt ein kleines Abbild 
der einzelnen Dateien oder Ordner (wenn Sie eine Box oder einen Ordner im linken Fensterausschnitt markieren), 
bzw. der einzelnen Seiten an (wenn Sie ein Dokument im linken Fensterausschnitt markieren) sowie den Dateinamen 
oder die Seitenzahl und ein Kontrollkästchen. Markieren Sie die Kontrollkästchen, um die Dateien oder Seiten 
auszuwählen, die Sie verschieben, kopieren, löschen oder drucken wollen.
Um zur Miniaturansicht zurückzukehren, wählen Sie [Ansicht (View)] > [Miniaturansicht (Thumbnail)].
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 Listenansicht verwenden
Diese Ansicht zeigt die Box-, Ordner- oder Dateinamen mit Eigenschaften und Kontrollkästchen in einem Listenformat 
an. Diese Ansicht ist beim Verwalten von Boxen und Ordnern, die eine große Anzahl von Dateien enthalten, besser 
geeignet als die Miniaturansicht. Markieren Sie das Kontrollkästchen von einer oder mehreren Dateien, die Sie 
verschieben, kopieren, löschen oder drucken wollen.
Zur Listenanzeige Ihrer Dateien wählen Sie [Ansicht (View)] > [Liste (List)].

Dokumente umbenennen
Mit folgenden Schritten können Sie Dokumente umbenennen.

Hinweis

Schalten Sie das Gerät beim Ändern des Dokumentnamens nicht aus. Das Dokument geht verloren, wenn das Gerät 
ausgeschaltet wird, während das System einen neuen Namen speichert.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie umbenennen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.
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3 Markieren Sie das Kontrollkästchen des Dokuments, das Sie umbenennen wollen, und wählen Sie 
[Datei (File)] > [Umbenennen (Rename)].

Das Fenster Dokument umbenennen wird angezeigt.

Tipp
Anwender können ein Dokument auch umbenennen, indem sie das Dokument auswählen und [Datei (File)] > 
[Umbenennen (Rename)] wählen.

4 Geben Sie den Dokumentnamen ein und klicken Sie auf [OK].

Das Bestätigungs-Dialogfeld erscheint.

Hinweis

Dokumentnamen bestehen aus dem ASCII-Zeichensatz, außer:
\ / < > " % & = ' ; : * ? | # [ ] { }. 
Verwenden Sie keine Leerstelle oder einen Punkt am Anfang oder am Ende des Namens. Die maximale Länge für 
einen Dokumentnamen beträgt 64 Zeichen.

5 Klicken Sie auf [OK].

Das Dokument ist umbenannt.
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Dokumente löschen
Mit folgenden Schritten können Sie Dokumente aus einer Box oder einem Ordner löschen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie löschen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie die Kontrollkästchen der Dokumente, die Sie löschen wollen, und wählen Sie 
[Bearbeiten (Edit)] > [Löschen (Delete)].

Das Bestätigungs-Dialogfeld erscheint.

Hinweis

Anwender können ein Dokument auch löschen, indem sie es auswählen und [Bearbeiten (Edit)] > [Löschen 
(Delete)] wählen. In diesem Fall sollten Sie sicherstellen, dass keine Seiten im Inhaltsabschnitt markiert sind. 
Wenn Seiten markiert sind, wird eine Warnmeldung angezeigt, weil Seiten im Ansichtsmodus nicht gelöscht 
werden können.

4 Klicken Sie auf [OK].

Die Dokumente sind gelöscht.
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Dokumente drucken
Sie können Dokumente und Bilder aus Boxen und Ordnern im e-Filing Dienstprogramm drucken.

 Dokument vollständig drucken
Zum Drucken des gesamten Dokuments mit einstellbaren Druckoptionen.

1 Wählen Sie im Dokumentfenster die Box oder den Ordner mit dem Dokument, das Sie drucken 
wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie das Kontrollkästchen des Dokuments, das Sie drucken wollen, und wählen Sie 
[Datei (File)] > [Dokument drucken (Print Document)].

Das Fenster Drucken wird angezeigt.

Hinweis

Sie können das Dokument auch drucken, indem Sie es markieren und [Datei (File)] > [Dokument drucken (Print 
Document)] wählen. Allerdings können Sie keine einzelnen Seiten ausdrucken, auch wenn Sie die 
Kontrollkästchen der Seiten im Fensterausschnitt markiert haben.
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4 Definieren Sie ggf. folgende Druckoptionen und klicken Sie auf [Drucken (Print)].

 Duplex — Legen Sie fest, ob das Dokument beidseitig ausgedruckt werden soll. Sie können die Buch- oder 
Kalenderform wählen.

 Kopienanzahl — Geben Sie die Anzahl der zu druckenden Kopien ein.

 Kopien sortieren — Wählen Sie diese Option, um das Dokument in separaten Kopien auszudrucken.

 Kopien gruppieren — Wählen Sie diese Option, um die Seiten des Dokuments separat zu drucken.

 Kopien gedreht Sortieren — Wählen Sie diese Option, um bei jeder Kopie die Ausrichtung des Blattes zu 
wechseln.

 Papiertyp — Wählen Sie den Papiertyp aus.

 Abteilungscode — Falls erforderlich, geben Sie den 1 bis 63-stelligen Abteilungscode ein. Wenn diese 
Funktion im Gerät aktiviert ist, müssen Sie einen Abteilungscode eingeben, um ein Dokument drucken zu 
können.

 Projektcode — Falls erforderlich, geben Sie den 1 bis 63-stelligen Projektcode ein. Wenn diese Funktion im 
Gerät aktiviert ist, müssen Sie einen Projektcode eingeben, um ein Dokument drucken zu können.

 Papierquelle — Wählen Sie einen Papiereinzug aus. Wählen Sie eine Papierquelle, die mit dem eingestellten 
Papierformat übereinstimmt.

 Ziel — Wählen Sie das Ausgabefach für das Dokument aus.

 Heften — Wählen Sie, ob das Dokument geheftet werden soll. Wenn ja, legen Sie fest, wie das Dokument 
geheftet werden soll.

 Bindung — Wählen Sie, ob das Dokument in der Mitte gefalzt und geheftet werden soll. Sie können die Art der 
Bindung einstellen.
- Mittelfalz — Das Dokument wird in der Mitte gefalzt.

- Broschürenheftung — Das Dokument wird in der Mitte doppelt geheftet und gefalzt.

 Locher — Wählen Sie, ob das Dokument gelocht werden soll. Wenn ja, legen Sie fest, wie das Dokument 
gelocht werden soll.
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 Seitennummer — Wählen Sie, ob Seitennummern gedruckt werden sollen.
- Position — Wählen Sie, wo die Seitennummern gedruckt werden sollen. Legen Sie die Position fest, an der 

die Seitennummer gedruckt werden soll.

- Erste Seite — Geben Sie die Seitenzahl für die erste Seite des Dokuments ein. Wenn “Vorderes Deckblatt 
verwenden” eingestellt ist, wird das Deckblatt als erste und die erste Dokumentseite als zweite Seite 
gezählt.

 Zeitstempel — Wählen Sie, ob ein Zeitstempel auf jeder Seite gedruckt werden soll.
- Position — Wählen Sie, wo die Zeitstempel gedruckt werden sollen. Legen Sie die Position fest, an der der 

Zeitstempel gedruckt werden soll.

 Randversatz — Wählen Sie, ob das Druckbild verschoben werden soll.
- Position — Legen Sie die Position für die Bildverschiebung fest.

- Randänderung - Vorderseite — Wählen Sie die Breite des Randes für die Vorderseite, um den das Druckbild 
versetzt wird.

- Randänderung - Rückseite — Wählen Sie die Breite des Randes für die Rückseite, um den das Druckbild 
versetzt wird.

 Abdeckung/Blatt einlegen — Legen Sie fest, ob ein vorderes oder hinteres Deckblatt gedruckt werden soll.
- Vord. Deckblatt verw. — Mit dieser Option können Sie ein vorderes Deckblatt einfügen oder drucken, das 

aus einer anderen Papierquelle zugeführt wird. Um den Deckblattdruck zu aktivieren, markieren Sie das 
Kontrollfeld und wählen den Ort, von dem das Deckblatt zugeführt werden soll, sowie den Druckstil.

- Hint. Deckblatt verw. — Mit dieser Option können Sie ein hinteres Deckblatt einfügen oder drucken, das 
aus einer anderen Papierquelle zugeführt wird. Um den Deckblattdruck zu aktivieren, markieren Sie das 
Kontrollfeld und wählen den Ort, von dem das Deckblatt zugeführt werden soll, sowie den Druckstil.

- Seiten einfügen — Mit dieser Option können Sie ein Blatt zwischen den Seiten einfügen, oder eine 
bestimmte Seite auf ein Blatt drucken, das aus einer anderen Papierquelle zugeführt wird. Die Funktion ist 
nützlich, wenn Sie zwischen Kapiteln ein leeres Blatt einfügen oder Kapiteldeckblätter auf anderem Papier 
ausdrucken möchten. Um den Druck der zugeschossenen Seiten zu aktivieren, markieren Sie das 
Kontrollfeld und wählen den Ort, von dem das Blatt zugeführt werden soll, sowie den Druckstil. Tragen Sie 
dann die Seitenzahlen, die Sie einfügen möchten, mit Kommata getrennt in das Feld [Seiten (Pages)] ein.

- Einlageblattseiten — Mit dieser Option können Sie Zwischen-/Trennblätter eines anderen Papiertyps (oder 
aus einer anderen Papierquelle) zwischen jede Seite des Druckjobs einfügen. Sie können hiermit 
beispielsweise leere Farbblätter zwischen Overheadfolien einfügen. Um dies zu aktivieren, markieren Sie 
das Kontrollfeld und wählen den Ort, von dem aus die Blätter zugeführt werden sollen. Markieren Sie das 
Kontrollfeld [Duplizieren (Duplicate)], wenn der letzte Ausdruck auf dem Trennblatt wiederholt werden soll.

- Papiertyp (Einfügen) — Wenn Sie den Stapelblatteinzug als Papierquelle für vorderes Deckblatt, hinteres 
Deckblatt, Zwischenblatt oder Trennblatt wählen, können Sie zusätzlich den Papiertyp einstellen.

 Geplanter Druck — Markieren Sie dies, einen Job zu einem späteren Zeitpunkt zu drucken. Wenn Sie dies 
auswählen, müssen Sie Datum und Uhrzeit einstellen.

Hinweis

 Die maximale Kopienzahl ist modellabhängig.
 Die Option [Kopien Sortierung Umkehren (Rotate Sort Copies)] ist nur verfügbar, wenn mehr als eine Kopie in 

[Kopienzahl (Number of Copies)] eingestellt ist. Für die Drehsortierung muss Papier im Hoch- und Querformat 
in den Kassetten eingelegt sein. Bei dieser Einstellung erfolgt die Ausgabe automatisch im Innenfach. Diese 
Funktion ist für einige Modelle nicht verfügbar.

 “Heften”, “Broschüre erstellen” oder “Lochung” kann nur aktiviert werden, wenn die entsprechende Einheit 
(optional) installiert ist. Zu Einzelheiten über die Finisher-Optionen siehe nachfolgende Referenz:
Spezifikationen - SPEZIFIKATIONEN DER OPTIONEN - Optionen Übersicht - Endverarbeitungsmodi und 
optionale Finisher

 Die Optionen “Heften” und “Abdeckung/Blatt einlegen - Einlageblattseiten” können nicht gleichzeitig 
verwendet werden. Wenn Sie eines aktivieren, wird das andere automatisch deaktiviert.
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Tipp

 Nach Klicken auf [Drucken (Print)] wird das Dokument gedruckt und das Druckergebnis angezeigt.
 Nach Klicken auf [Abbrechen (Cancel)] wird der Druck nicht durchgeführt und das Druckfenster geschlossen.
 Nach Klicken auf [Zurücksetzen (Reset)] werden die Druckeinstellungen zurückgesetzt.
 Wenn [Abdeckung/Blatt einlegen - Vord. Deckblatt verw. (Cover/Sheet Insertion - Use Front Cover)] 

ausgewählt ist, wird die Vorderseite als Seite “1” angenommen und die gedruckten Seitenzahlen beginnen mit 
“2”.

 Ist die Benutzerverwaltung und die Abteilungsverwaltung aktiviert, wird die maximale Kopienzahl für die 
Abteilung bzw. den Anwender oben rechts auf der Seite angezeigt.

5 Klicken Sie auf [Schließen (Close)], um zum Registerfenster [Dokumente (Documents)] 
zurückzukehren.

Tipp
Um einen laufenden Druckvorgang abzubrechen, öffnen Sie TopAccess, klicken auf [Job Status] > [Drucken 
(Print)], wählen den Druckjob und klicken auf [Löschen (Delete)].

 Testdruck
Mit der Testdruck-Funktion können Sie auf einfache Weise eine Kopie des Dokuments unter Verwendung der 
bestehenden Druckeinstellungen erstellen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie drucken wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.
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3 Markieren Sie das Kontrollkästchen des Dokuments, das Sie drucken wollen, und wählen Sie 
[Datei (File)] > [Testdruck (Test Print)].

Das Fenster Testdruck wird angezeigt.

Hinweis

Sie können den Testdruck auch vornehmen, indem Sie ein Dokument im Dokumentfenster markieren und im 
Menü [Datei (File)] die Option [Testdruck (Test Print)] benutzen. Allerdings können Sie keine einzelnen Seiten 
ausdrucken, auch wenn Sie die Kontrollkästchen der Seiten im Inhaltsfenster markiert haben.

4 Wählen Sie, ob Sie alle oder nur bestimmte Seiten drucken wollen und klicken Sie auf [Drucken 
(Print)].

 Alle Seiten — Wählen Sie dies, um alle Seiten des Dokuments zu drucken.

 [von Seite (first page number)] - [bis Seite (last page number)] — Es werden nur definierte Seiten des 
Dokuments gedruckt. Wenn diese Option gewählt ist, geben Sie die erste Seitenzahl und die letzte Seitenzahl 
in die entsprechenden Felder ein.

 Abteilungscode — Geben Sie den fünfstelligen Abteilungscode ein. Er muss nur eingegeben werden, wenn die 
Abteilungscodefunktion in Ihrem Gerät aktiviert ist.

 Projektcode — Geben Sie den Projektcode ein. Er muss nur eingegeben werden, wenn die 
Projektcodefunktion aktiviert ist.

Tipp

 Ist die Benutzerverwaltung und die Abteilungsverwaltung aktiviert, wird die maximale Kopienzahl für die 
Abteilung bzw. den Anwender oben rechts auf der Seite angezeigt.

 Nach Klicken auf [Drucken (Print)]wird das Dokument gedruckt und das Druckergebnis angezeigt.
 Nach Klicken auf [Abbrechen (Cancel)] wird das Druckfenster geschlossen.

5 Klicken Sie auf [Schließen (Close)], um zum Registerfenster [Dokumente (Documents)] 
zurückzukehren.

Hinweis

Um einen laufenden Druckvorgang abzubrechen, öffnen Sie TopAccess, klicken auf [Job Status] > [Drucken 
(Print)], wählen den Druckjob und klicken auf [Löschen (Delete)].
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Dokumente mit dem Druckertreiber speichern
Sie können aus einer Anwendung, die unter Windows läuft, ein Dokument mit dem Druckertreiber wie einen 
Druckauftrag an e-Filing senden.
Sie können den Druckauftrag in der öffentlichen Box oder in einer Benutzerbox speichern.

Hinweis

Wenn Sie ein Dokument in e-Filing mit dem Druckertreiber speichern, wird das Druckdokument (nicht das 
Originaldokument) in e-Filing gespeichert.

Tipp

 Zu Einzelheiten über Druckertreiber siehe nachfolgende Referenzen:
Druckfunktionen - AUS WINDOWS ANWENDUNGEN DRUCKEN - Druckertreiber Funktionen
Druckfunktionen - AUS macOS-ANWENDUNGEN DRUCKEN - Druckertreiber Funktionen

 Einzelheiten zur öffentlichen Box und Benutzerbox siehe nachfolgende Referenz:
 S.8 “e-Filing Merkmale”

 Sie können Dokumente über den Touch Screen des Systems in e-Filing speichern. Zu den Einzelheiten siehe 
nachfolgende Referenz: 
 S.19 “Dokumente speichern”

 Druckauftrag in einer öffentlichen Box speichern

1 Öffnen Sie das Dokument, das Sie in der Box speichern wollen.

2 Wählen Sie in Ihrer Anwendung [Datei (File)] > [Drucken (Print)].
Das Dialogfeld [Drucken (Print)] wird angezeigt.

3 Wählen Sie den gewünschten Druckertreiber und klicken auf [Einstellungen (Preferences)].
Das Dialogfeld [Druckeinstellungen (Printing Preferences)] erscheint.

Tipp
Die Vorgehensweise zur Anzeige des Dialogs [Druckeinstellungen (Printing Preferences)] ist je nach 
Anwendungsprogramm unterschiedlich. Lesen Sie im Zweifelsfall das Handbuch der entsprechenden 
Anwendung.

4 Wählen Sie im Register [Basis (Basic)] den Typ des Druckjobs.
Wählen Sie [Speichern in e-Filing (Store to e-Filing)] unter [Druckauftrag (Print Job)].
Falls erforderlich, wählen Sie weitere Druckoptionen aus.

Tipp

 Je nach eingestellter Druckoption wird der Druckjob gespeichert.
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 Die Druckoptionen außer [Kopienzahl (Number of Copies)] werden als Job definiert und in der öffentlichen 
Box gespeichert.

5 Wählen Sie [Öffentliche Box (Public Box)] und klicken Sie auf [OK].

Tipp

 Geben Sie den Ordnernamen in [Box Ordner (Box Folder)] ein, wenn Sie den Druck in einem bestimmten 
Ordner speichern wollen.
Geben Sie einen existierenden Ordnernamen in [Box Ordner (Box Folder)] ein, um die Druckdaten zu 
speichern.
Geben Sie einen neuen Ordnernamen ein, um einen neuen Ordner zu erstellen und die Druckdaten darin zu 
speichern.
Zu Einzelheiten über die Authentifizierungseinstellung der öffentlichen Box siehe nachfolgende Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Authentifizierungseinstellungen - 
Authentifizierung Öffentliche Box 

 Wenn Sie einen Auftrag drucken und gleichzeitig in einer öffentlichen Box speichern wollen, markieren Sie die 
Option [Drucken (Print)].
Ein Druckjob wird in dem Farbmodus gedruckt, der unter [Farbe (Color)] im Register [Basis (Basic)] eingestellt 
ist.

6 Klicken Sie auf [OK] oder [Drucken (Print)], um den Druckauftrag abzusenden.
Der Druckjob wird in der öffentlichen Box gespeichert.

 Druckauftrag in einer Benutzerbox speichern

1 Öffnen Sie das Dokument, das Sie in der Box speichern wollen.

2 Wählen Sie in Ihrer Anwendung [Datei (File)] > [Drucken (Print)].
Das Dialogfeld [Drucken (Print)] wird angezeigt.
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3 Wählen Sie den gewünschten Druckertreiber und klicken auf [Einstellungen (Preferences)].
Das Dialogfeld [Druckeinstellungen (Printing Preferences)] erscheint.

Tipp
Die Vorgehensweise zur Anzeige des Dialogs [Druckeinstellungen (Printing Preferences)] ist je nach 
Anwendungsprogramm unterschiedlich. Lesen Sie im Zweifelsfall das Handbuch der entsprechenden 
Anwendung.

4 Wählen Sie im Register [Basis (Basic)] den Typ des Druckjobs.
Wählen Sie [Speichern in e-Filing (Store to e-Filing)] unter [Druckauftrag (Print Job)].
Falls erforderlich, wählen Sie weitere Druckoptionen aus.

Tipp

 Je nach eingestellter Druckoption wird der Druckjob gespeichert.
 Die Druckoptionen außer [Kopienzahl (Number of Copies)] werden als Job definiert und in der Benutzerbox 

gespeichert.

5 Wählen Sie eine Benutzerbox aus.
 Wählen Sie die Nr. der Benutzerbox unter [Speichern in (Store to)].

 Geben Sie das Kennwort für die Benutzerbox im Feld [Kennwort (Password)] ein.

 Wenn Sie einen Auftrag drucken und gleichzeitig in einer öffentlichen Box speichern wollen, markieren Sie die 
Option [Drucken (Print)]. Ein Druckjob wird in dem Farbmodus gedruckt, der unter [Farbe (Color)] im Register 
[Basis (Basic)] eingestellt ist.
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Hinweis

Wenn die Option SNMP-Kommunikation aktivieren im Register [Andere (Others)] aktiviert ist, werden nur die 
eingerichteten Benutzerboxen in der Dropdown-Liste angezeigt.

Tipp
Geben Sie den Ordnernamen in [Box Ordner (Box Folder)] ein, wenn Sie den Druck in einem bestimmten Ordner 
speichern wollen.
Geben Sie einen existierenden Ordnernamen in [Box Ordner (Box Folder)] ein, um die Druckdaten zu speichern.
Geben Sie einen neuen Ordnernamen ein, um einen neuen Ordner zu erstellen und die Druckdaten darin zu 
speichern.

6 Klicken Sie auf [OK] oder [Drucken (Print)], um den Druckauftrag abzusenden.
Der Druckjob wird in der ausgewählten Benutzerbox gespeichert.
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Dokumente archivieren
Sie können die in e-Filing gespeicherten Dokumente archivieren und die Archivdateien auf Ihren Computer 
herunterladen. Diese Dateien können auch von Ihrem Computer in das e-Filing des Systems oder in Equipment der 
gleichen e-STUDIO Serie geladen werden.

Tipp
Die Archivdateien sind nur mit Systemen der gleichen Serie kompatibel.

 Archiviertes Dokument herunterladen
Sie können Ihre Dokumente in der Box archivieren und in Ihren Computer laden. Verwenden Sie diese Funktion, um 
eine Sicherungsdatei Ihrer Dokumente in e-Filing zu erstellen.

Hinweis

 Die Archivdatei enthält alle ausgewählten Dokumente, aber Sie können die Dokumente nicht auf Ihrem Computer 
öffnen.

 Die Archivdatei kann mehrere Dokumente eines Ordners oder einer Box enthalten.
 Sie können keine Archivdatei erstellen, die mehr als 2 GB Daten enthält.
 Schließen Sie Hauptfenster und Nebenfenster nicht, indem Sie auf das Symbol [X] klicken. Wenn Sie dies tun, wird 

der Download der archivierten Dokumente unmöglich. Falls Sie das Fenster versehentlich durch einen Klick auf das 
Symbol [X] geschlossen haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie archivieren wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.
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3 Markieren Sie das Kontrollkästchen des Dokuments, das Sie archivieren wollen, und wählen Sie 
[Datei (File)] > [Dokument archivieren (Archive Document)].

Das Bestätigungs-Dialogfeld erscheint.

Hinweis

Anwender können ein Dokument auch archivieren, indem sie das Dokument auswählen und [Datei (File)] > 
[Dokument archivieren (Archive Document)] wählen. Allerdings können Sie keine einzelnen Seiten archivieren, 
auch wenn Sie die Kontrollkästchen der Seiten markiert haben.

4 Klicken Sie auf [OK], um die Archivierung zu starten.

5 Das Fenster Dokument archivieren wird angezeigt. Sie können den laufenden Archivierungs-
prozess beenden, indem Sie auf [Abbrechen (Cancel)] klicken.

Wenn die Archivierung abgeschlossen ist, erhalten Sie die Meldung: “Ihr Dokument wurde erfolgreich archiviert”.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.

6 Klicken Sie auf den Dateinamen-Link, um die Archivdatei herunter zu laden.

Die Dateien werden in den Download-Ordner Ihres Browsers gespeichert.
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7 Klicken Sie auf [Schließen (Close)].

 Archivierte Dokumente heraufladen
Wenn Sie über eine Archivdatei verfügen, die vom System auf Ihren Computer heruntergeladen wurde, können Sie sie 
wieder in die e-Filing-Box heraufladen. Wenn Sie die Archivdatei heraufladen, wird die Archivdatei automatisch 
extrahiert, und die Dokumente werden in der angegebenen Box erstellt.

Hinweis

 Existiert in der Box ein Dokument mit demselben Namen, wird das extrahierte Dokument umbenannt, indem eine 
dreistellige Zahl dem ursprünglichen Namen hinzugefügt wird.

 Schließen Sie Hauptfenster und Nebenfenster nicht, indem Sie auf das Symbol [X] klicken. Wenn Sie dies tun, wird 
das Heraufladen der archivierten Dokumente unmöglich. Falls Sie das Fenster versehentlich durch einen Klick auf 
das Symbol [X] geschlossen haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner in den Sie die archivierten Dokumente laden wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die Kennwort-
eingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie [Datei (File)] > [Archiviertes Dokument heraufladen (Upload Archived Document)].

Die Seite [Archiviertes Dokument heraufladen (Upload Archived Document)] wird angezeigt.
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4 Klicken Sie auf [Datei wählen (Choose File)].

Das Dialogfeld zur Dateiauswahl erscheint.

5 Wählen Sie eine Archivdatei zum Heraufladen aus und klicken Sie auf [Öffnen (Open)].

Das vorherige Fenster kehrt zurück und der Ordnerpfad der ausgewählten Datei wird unter [Archivdatei (Archived 
File)] angezeigt.

6 Klicken Sie auf [OK].

Der Bestätigungsdialog erscheint.

7 Klicken Sie auf [OK], um die Archivdatei herauf zu laden.

Hinweis

Wenn Sie keine Archivdatei oder eine nicht von Ihrem Modell unterstützte Archivdatei auswählen, wird eine 
Fehlermeldung angezeigt. Wählen Sie die korrekte Archivdatei und wiederholen Sie den Vorgang.
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8 Der Fortschritt des Heraufladens wird in einem Fenster angezeigt. Während des Heraufladens 
können Sie auf [Abbrechen (Cancel)] klicken, um den Prozess zu beenden.

Wenn der Ladevorgang abgeschlossen ist, erhalten Sie die Meldung: “Das Dokument wurde erfolgreich 
heraufgeladen”.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.

9 Klicken Sie auf [Schließen (Close)].

Die Dokumente werden der ausgewählten Box hinzugefügt.

Email Senden
Sie können im e-Filing Dienstprogramm ausgewählte Dokumente als Email senden.
Mit dieser Funktion werden die Dokumente als Datei-Anhänge direkt vom System als Email gesendet.

Hinweis

 Um die Funktion zu benutzen, muss die Email-Konfiguration vom Netzwerkadministrator durchgeführt worden 
sein.

 Mit einem multifunktionalen digitalen Farbsystem (Farb-Multifunktionssystem) können Sie nur dann e-Filing 
Dokumente als Email senden, wenn diese wie folgt gespeichert wurden. Prüfen Sie daher die 
Dokumenteigenschaften vor dem Senden.
- Dokumente, die mit der Kopierfunktion in schwarzweiß und im Modus Text/Foto oder Text gespeichert wurden
- Dokumente, die mit der Scanfunktion des Systems gespeichert wurden
- Dokumente, die als Fax/Internetfax empfangen und mit der Transferfunktion gespeichert wurden

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie als Email senden wollen.
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2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie das Kontrollkästchen des Dokuments, das Sie als Email senden wollen, und wählen 
Sie [Datei (File)] > [Email senden (Send Email)].

Die Registerseite Email senden wird angezeigt.

Tipp

 Anwender können ein Dokument auch als Email senden, indem sie das Dokument auswählen und [Datei 
(File)] > [Email senden (Send Email)] wählen.

 Sie können auch bis zu 100 einzelnen Seiten senden, indem Sie die Kontrollkästchen der Seiten markieren.
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4 Definieren Sie ggf. folgende Positionen und klicken Sie auf [Senden (Send)].

[AN: Zieleinstellung (Destination Setting)] — Klicken Sie hier, um das Ziel festzulegen. Wenn Sie darauf klicken, 
wird die Empfängerliste angezeigt. Zum Auswählen von Empfängern siehe nachfolgende Referenz:
 S.71 “Zieleinstellung”
[CC: Zieleinstellung (Destination Setting)] — Klicken Sie hier, um das CC-Ziel festzulegen.
[BCC: Zieleinstellung (Destination Setting)] — Klicken Sie hier, um das BCC-Ziel festzulegen.
Betreff — Zum Festlegen eines Betreffs für die Email-Sendung. Wählen Sie die Voreinstellung [Daten senden von 
(Systemname) (Box Info.) (Send data from (Device name) (Box Info.))] oder geben Sie einen anderen Betreff in das 
Feld ein. Zum Hinzufügen von Datum und Uhrzeit an den Betreff, markieren Sie das Kontrollfeld [Datum und 
Uhrzeit dem Betreff hinzufügen (Add the date and time to the subject)].
Absenderadresse — Geben Sie die Absenderadresse ein. Wenn der Empfänger antwortet, wird die Nachricht an 
diese Email-Adresse geschickt.
Von Name — Geben Sie den Absendernamen ein.
Sie können Ihre Adresse auch getrennt von der des Absenders festlegen. Zu den Einzelheiten dieser Einstellung 
siehe nachfolgende Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Authentifizierung Einstellungen - Email 
Adresse Einstellung
Haupttext — Geben Sie eine Textnachricht für das Email-Dokument ein. Sie können bis zu 1000 Zeichen 
(einschließlich Leerstellen) eingeben.
Dateiformat — Wählen Sie das Dateiformat, in das das Dokument konvertiert werden soll.
 TIFF (Multi) — Wählen Sie diese Option, um gescannte Bilder als mehrseitige TIFF-Datei zu speichern.

 TIFF (Single) — Wählen Sie diese Option, um gescannte Bilder als einseitige TIFF-Datei zu speichern.

 PDF (Multi) — Wählen Sie diese Option, um gescannte Bilder als mehrseitige PDF-Datei zu speichern.

 PDF (Single) — Wählen Sie diese Option, um gescannte Bilder als einseitige PDF-Datei zu speichern.

 XPS (Multi) — Wählen Sie diese Option, um gescannte Bilder als mehrseitige XPS-Datei zu speichern.

 XPS (Single) — Wählen Sie diese Option, um gescannte Bilder als einseitige XPS-Datei zu speichern.

 JPEG — Wählen Sie dies, um gescannte Bilder als JPEG-Datei zu speichern. Die Einstellung ist nur möglich, 
wenn [Vollfarbe (Full Color)] oder [Graustufen (Gray Scale)] als Farbmodus eingestellt ist.

Verschlüsselung — Wählen Sie dies, um PDF-Dateien zu verschlüsseln, wenn Sie “PDF (Multi)” oder “PDF 
(Single)” als Dateiformat eingestellt haben.
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 Verschlüsselung — Wählen Sie dies, wenn Sie die PDF-Datei verschlüsseln wollen.

 Benutzerkennwort — Geben Sie ein Kennwort zum Öffnen der verschlüsselten PDF-Datei ein.

 Master Kennwort — Geben Sie ein Kennwort zum Ändern der PDF-Verschlüsselungseinstellungen ein.

 Verschlüsselungsstufe — Wählen Sie die gewünschte Verschlüsselungsstufe.
- 40-bit RC4 — Zur Einstellung einer Verschlüsselungsstufe, die kompatibel mit Acrobat 3.0, PDF V1.1 ist. 

- 128-bit RC4 — Zur Einstellung einer Verschlüsselungsstufe, die kompatibel mit Acrobat 5.0, PDF V1.4 ist. 

- 128-bit AES — Zur Einstellung einer Verschlüsselungsstufe, die kompatibel mit Acrobat 7.0, PDF V1.6 ist.

- 256-bit AES — Zur Einstellung einer Verschlüsselungsstufe, die kompatibel mit Acrobat 9.0, PDF V1.7 ist.

 Berechtigung — Wählen Sie die Berechtigungen für die verschlüsselte PDF.
- Drucken

- Dokumente ändern

- Inhalt kopieren oder extrahieren

- Inhalt zum Zugriff extrahieren
Dateiname — Wählen Sie einen Namen für die angehängte Datei.
Digitale Signatur — Wählen Sie [Aktivieren], um eine PDF mit digitaler Signatur zu senden.
Fragmentierungsgröße — Wählen Sie eine Größe, ab der das Dokument aufgeteilt werden soll.
Abteilungscode — Falls erforderlich, geben Sie den Abteilungscode ein.
Projektcode — Falls erforderlich, geben Sie den Projektcode ein.

Hinweis

 Ist die Verschlüsselung zwingend erforderlich, können nur [PDF (Multi) (PDF (Multi))] und [PDF (Single) (PDF 
(Single))] als Dateiformat gewählt werden. Zu Einzelheiten über die zwingende Verschlüsselung siehe 
nachfolgende Referenz:
Benutzerfunktionen - EINSTELLUNGEN (Admin) - Sicherheit - Sichere PDF Einstellung

 Diese Kennwörter können nur von autorisierten Anwendern neu vergeben werden. Anwender können die 
Felder [Verschlüsselungsstufe (Encryption Level)] und [Berechtigung (Authority)] nur ändern, wenn sie auch 
dazu befugt sind, das Masterkennwort zu ändern. Die Einstellung der Verschlüsselung ist möglich, wenn das 
Benutzerkennwort oder das Masterkennwort eingegeben wurde. Zu Einzelheiten über die Verschlüsselung 
siehe nachfolgende Referenz:
Benutzerfunktionen - EINSTELLUNGEN (Admin) - Sicherheit - Sichere PDF Einstellung
Fragen Sie Ihren Administrator, wenn Sie diese Kennwörter festlegen wollen. 

Tipp

 Ist die generelle Verschlüsselung aktiviert, kann sie nicht zurückgenommen werden indem die Markierung des 
Kontrollfelds entfernt wird. Zu Einzelheiten über die zwingende Verschlüsselung siehe nachfolgende Referenz:
Benutzerfunktionen - EINSTELLUNGEN (Admin) - Sicherheit - Sichere PDF Einstellung

 Für das Benutzerkennwort und das Masterkennwort existiert keine Voreinstellung. Bitte wenden Sie sich an 
Ihren Administrator, wenn die Eingabe eines Masterkennworts erforderlich ist.

 Die Kennwörter müssen als alphanumerische Zeichen (1 Byte) eingegeben werden. Mindestens eins, maximal 
32 Zeichen.

 Das Benutzerkennwort muss sich vom Masterkennwort unterscheiden.

5 Klicken Sie auf [Schließen (Close)].
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 Zieleinstellung
Auf dieser Seite können Sie Ziele definieren, an die e-Filing Dokumente als Email gesendet werden.
Sie können die Empfänger manuell mit Email-Adressen oder Faxnummern angeben, Empfänger oder 
Empfängergruppen aus dem Adressbuch wählen oder Empfänger auf dem LDAP-Server suchen.

Hinweis

Wenn [LDAP Authentifizierung (LDAP Authentication)] unter [Authentifizierungstyp (Authentication Type)] ausgewählt 
wurde, können Sie nur die Ziele auswählen, die auf dem LDAP Server registriert sind. Zu Einzelheiten über die LDAP-
Authentifizierung siehe nachfolgende Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Authentifizierungseinstellungen - 
?Benutzerauthentifizierung Einstellung

Tipp
Sie können in der Empfängerliste bis zu 400 Ziele festlegen.

Empfänger manuell eingeben
Führen Sie folgende Schritte aus, um Empfänger manuell einzugeben.

1 Klicken Sie auf Ziel, damit die Empfängerliste angezeigt wird.

2 Klicken Sie auf [Neu (New)].

Das Fenster Kontakteigenschaften wird angezeigt.

3 Geben Sie die Email-Adresse des Empfängers ein und klicken Sie auf [OK].

Der eingegebene Empfänger wird der Empfängerliste hinzugefügt.

4 Wiederholen Sie ggf. die Schritte 2 bis 3 für weitere Empfänger.

Tipp
Sie können vor dem Speichern der Liste noch Empfänger aus der Liste löschen.
 S.75 “Kontakte aus der Empfängerliste entfernen”

5 Klicken Sie auf [Speichern (Save)].

Die Kontakte werden als Ziele hinzugefügt.
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Empfänger aus dem Adressbuch wählen
Führen Sie folgende Schritte aus, um Empfänger aus dem Adressbuch zu wählen.

1 Klicken Sie auf Ziel, damit die Empfängerliste angezeigt wird.

2 Klicken Sie auf [Adressbuch (Address Book)].

Das Adressbuch wird angezeigt.

3 Wählen Sie die Email-Kontakte aus und klicken Sie auf [Hinzufügen (Add)].

Die gewählten Empfänger werden der Empfängerliste hinzugefügt.

Tipp

 Wenn Sie die Empfänger nach Gruppen sortieren wollen, wählen Sie unter [Gruppe (Group)] die gewünschte 
Gruppe aus.

 Sie können vor dem Speichern der Liste noch Empfänger aus der Liste löschen.
 S.75 “Kontakte aus der Empfängerliste entfernen”

4 Klicken Sie auf [Speichern (Save)].

Die Kontakte werden als Ziele hinzugefügt.
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Empfängergruppen aus dem Adressbuch wählen
Führen Sie folgende Schritte aus, um Empfängergruppen aus dem Adressbuch zu wählen.

1 Klicken Sie auf Ziel, damit die Empfängerliste angezeigt wird.

2 Klicken Sie auf [Adressengruppe (Address Group)].

Das Fenster Adressengruppe wird angezeigt.

3 Wählen Sie die Empfängergruppen aus und klicken Sie auf [Hinzufügen (Add)].

Alle Empfänger in den gewählten Gruppen werden der Empfängerliste hinzugefügt.

Tipp
Sie können vor dem Speichern der Liste noch Empfänger aus der Liste löschen.
 S.75 “Kontakte aus der Empfängerliste entfernen”

4 Klicken Sie auf [Speichern (Save)].

Die Kontakte werden als Ziele hinzugefügt.
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Empfänger auf dem LDAP-Server suchen
Führen Sie folgende Schritte aus, um Empfänger auf dem LDAP-Server zu suchen.

Tipp
Um Empfänger auf dem LDAP-Server zu suchen, müssen Einstellungen für den Verzeichnisdienst im 
Administratormodus von TopAccess durchgeführt worden sein. Zu den Einzelheiten siehe nachfolgende Referenz: 
TopAccess - [Administration] - [Setup] Elemente - Netzwerkeinstellungen - LDAP Client Einstellungen

1 Klicken Sie auf Ziel, damit die Empfängerliste angezeigt wird.

2 Klicken Sie auf [Suchen (Search)].

Das Fenster Kontakt suchen wird angezeigt.

3 Definieren Sie die Suchbedingung und klicken Sie auf [Suchen (Search)].
Wählen Sie den Verzeichnisdienst unter [Namen des Verzeichnisdienstes (Directory Service Name)] aus und 
geben Sie die Suchbegriffe in die betreffenden Felder ein.

TopAccess beginnt auf dem LDAP-Server mit der Suche nach Empfängern und das Ergebnis der Suche wird 
angezeigt.

Tipp

 Wenn Sie in der Auswahlliste [Name des Verzeichnisdienstes (Directory Service Name)] den Modellnamen 
dieses Geräts wählen, können Sie im Adressbuch des Geräts nach Empfängern suchen.

 TopAccess sucht nach Empfängern, die den Einträgen entsprechen.
 Sie müssen mindestens eins der Felder ausfüllen, um gezielt suchen zu können.
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4 Wählen Sie die Email-Kontakte aus und klicken Sie auf [Hinzufügen (Add)].

Die gewählten Empfänger werden der Empfängerliste hinzugefügt.

Tipp
Sie können vor dem Speichern der Liste noch Empfänger aus der Liste löschen.
 S.75 “Kontakte aus der Empfängerliste entfernen”

5 Klicken Sie auf [Speichern (Save)].

Die Kontakte werden als Ziele hinzugefügt.

Kontakte aus der Empfängerliste entfernen

1 Markieren Sie die Kontrollkästchen der Kontakte, die aus der Empfängerliste entfernt werden 
sollen, und klicken Sie auf [Entfernen (Delete)].

Die markierten Kontakte werden aus der Empfängerliste entfernt.
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0.Dokumentseiten bearbeiten

Mit dem e-Filing Dienstprogramm können Sie Änderungen an Ihren gespeicherten Dokumenten durchführen, bevor 
Sie sie drucken.
Im e-Filing Dienstprogramm gibt es drei Steuerungsschaltflächen: [Bearbeiten (Edit)], [Speichern (Save)] und 
[Abbrechen (Cancel)].
Diese Schaltflächen werden oben im Inhaltsfenster angezeigt, wenn Sie ein Dokument im Dokumentfenster 
auswählen. Die Anzeige der Schaltflächen hängt vom Status des Dokuments ab.
 [Bearbeiten (Edit)] — Klicken Sie hier, um mit der Bearbeitung des Dokuments zu beginnen. Diese Schaltfläche 

wird nur im Ansichtsmodus (Dokumentstatus “Ansicht”) angezeigt. Wenn Sie auf [Bearbeiten (Edit)] klicken, ändert 
sich der Dokumentstatus auf “Bearbeiten”, die Schaltflächen [Speichern (Save)] und [Abbrechen (Cancel)] werden 
anstelle von [Bearbeiten (Edit)] angezeigt, und Sie können das Dokument bearbeiten. Wenn Sie auf diese 
Schaltfläche klicken, während der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den 
Bearbeitungsmodus wechseln, und es erfolgt die Meldung “Das Dokument ist gerade geöffnet. Bitte versuchen Sie 
es später noch einmal.”

 [Speichern (Save)] — Klicken Sie hier, um das von Ihnen bearbeitete Dokument zu speichern. Diese Schaltfläche 
wird nur im Bearbeitungsmodus (Dokumentstatus “Bearbeiten”) angezeigt. Wenn Sie auf sie klicken, wird das 
Dokument gespeichert und wechselt in den Ansichtsmodus.

 [Abbrechen (Cancel)] — Klicken Sie hier, um zum Ansichtsmodus zurückzukehren, ohne das Dokument zu 
speichern. Diese Schaltfläche wird nur im Bearbeitungsmodus (Dokumentstatus “Bearbeiten”) angezeigt.

Der Dokumentstatus wird links von den Schaltflächen angezeigt. Als Dokumentstatus gibt es folgende Möglichkeiten:
 In Gebrauch — Damit wird angezeigt, dass ein anderer Anwender das Dokument gerade bearbeitet.
 Ansicht — Dies bedeutet, dass das Dokument gerade im Betrachtungsmodus ist, in dem Sie die Seiten nur 

betrachten können.
 Bearbeiten — Die bedeutet, dass das Dokument gerade im Bearbeitungsmodus ist und Sie das Dokument 

bearbeiten können.

Hinweis

Aktualisieren Sie beim Bearbeiten oder Löschen eines freigegebenen Dokuments die Anzeige, um den aktuellen 
Status des Dokuments zu sehen. Wird das Dokument von zwei oder mehr Personen gleichzeitig bearbeitet, kann es 
beschädigt werden.

Mit dem e-Filing Dienstprogramm können Sie Seiten kopieren, verschieben, löschen und einfügen sowie die 
Reihenfolge der Seiten in Ihrem Dokument ändern.
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Dokument- und Seiteneigenschaften anzeigen
Sie können die Fenster Dokumenteigenschaften und Seiteneigenschaften anzeigen, die die Details des Dokuments 
bzw. der Seite enthalten. Um das Fenster Dokumenteigenschaften anzuzeigen, markieren Sie das Kontrollkästchen 
eines Dokuments und wählen [Eigenschaften (Properties)] im Menü [Datei (File)]. Um das Fenster Seiteneigenschaften 
anzuzeigen, markieren Sie das Kontrollkästchen einer Seite und wählen [Seiteneigenschaften (Page Properties)] im 
Menü [Datei (File)].

Das Fenster Dokumenteigenschaften enthält die folgenden Informationen:

 Standort
Zeigt das Verzeichnis an, in dem sich das Dokument befindet.

 Seiten gesamt
Zeigt die Anzahl der Seiten an, die im Dokument enthalten sind.

 Größe
Zeigt die Datengröße des Dokuments an.

 Erstellt
Zeigt das Datum und die Uhrzeit für die Erstellung des Dokuments an.

 Modifiziert
Zeigt das Datum und die Uhrzeit für die letzte Änderung des Dokuments an.

 Zuletzt benutzt
Zeigt das Datum und die Uhrzeit an, wann das Dokument zuletzt benutzt wurde.

 [OK]
Klicken Sie auf diese Schaltfläche, um das Fenster zu schließen.

Das Fenster Seiteneigenschaften enthält die folgenden Informationen:

 Format
Zeigt an, wie die Seite gespeichert ist.

 Auflösung
Zeigt die Auflösung der Seite an

 Bildgröße
Zeigt die Pixelgröße der Seite an

 Papierformat
Zeigt das Papierformat der Seite an

 Größe
Zeigt die Datengröße der Seite an

 [OK]
Klicken Sie auf diese Schaltfläche, um das Fenster zu schließen.
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Seiten von einem Dokument in ein anderes kopieren
Sie können Seiten aus einem Dokument kopieren oder ausschneiden und in ein anderes Dokument einfügen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, dessen Seiten Sie kopieren oder ausschneiden wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie im Dokumentfenster das Dokument, dessen Seiten Sie kopieren oder ausschneiden 
wollen.

Die Seiten des Dokuments werden im Inhaltsfenster angezeigt.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.

Tipp
Wenn Sie Seiten ausschneiden wollen, klicken Sie auf [Bearbeiten (Edit)], um in den Bearbeitungsmodus zu 
wechseln. Nach Klicken auf [Bearbeiten (Edit)], wechselt der Dokumentstatus in den Bearbeitungsmodus, so 
dass Sie Seiten aus dem Dokument ausschneiden können.
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4 Markieren Sie die Kontrollkästchen der Seiten, die Sie kopieren oder ausschneiden wollen, und 
wählen Sie [Bearbeiten (Edit)] > [Kopieren (Copy)] oder [Ausschneiden (Cut)].

 Fahren Sie mit dem nächsten Schritt fort, wenn Sie Seiten aus dem Dokument ausgeschnitten haben.

 Fahren Sie mit dem Schritt 7 fort, wenn Sie Seiten aus dem Dokument kopiert haben.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.

5 Klicken Sie auf [Speichern (Save)], um das Dokument zu speichern.

Das Fenster Dokument speichern wird angezeigt.

6 Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den 
Dokumentnamen nicht ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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7 Wählen Sie im Dokumentfenster die Box oder den Ordner aus, der das Dokument enthält, in das 
Sie die kopierten Seiten einfügen wollen.

8 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

9 Wählen Sie im Dokumentfenster das Dokument aus, in das Sie die kopierten Seiten einfügen 
wollen und klicken Sie auf [Bearbeiten (Edit)].

Die Seiten des Dokuments werden angezeigt und der Dokumentstatus wechselt in den Bearbeitungsmodus.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.
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10Klicken Sie auf den Bereich zwischen den Seiten, in den Sie die kopierten Seiten einfügen wollen.

Die Pfeilmarken bewegen sich auf den Bereich zwischen den Seiten, auf den Sie geklickt haben.

11Wählen Sie [Bearbeiten (Edit)] > [Einfügen (Paste)].

Die kopierten Seiten werden zwischen die Seiten eingefügt.

12Klicken Sie auf [Speichern (Save)].

Das Fenster Dokument speichern wird angezeigt.
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13Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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Seiten aus einem Dokument in eine Box oder einen Ordner kopieren
Sie können Seiten aus einem Dokument kopieren oder ausschneiden und sie in eine Box oder einen Ordner einfügen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, dessen Seiten Sie kopieren oder ausschneiden wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie im Dokumentfenster das Dokument, dessen Seiten Sie kopieren oder ausschneiden 
wollen.

Die Seiten des Dokuments werden im Inhaltsfenster angezeigt.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.

Tipp
Wenn Sie Seiten ausschneiden wollen, klicken Sie auf [Bearbeiten (Edit)], um in den Bearbeitungsmodus zu 
wechseln. Nach Klicken auf [Bearbeiten (Edit)], wechselt der Dokumentstatus in den Bearbeitungsmodus, so 
dass Sie Seiten aus dem Dokument ausschneiden können.
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4 Markieren Sie die Kontrollkästchen der Seiten, die Sie kopieren oder ausschneiden wollen, und 
wählen Sie [Bearbeiten (Edit)] > [Kopieren (Copy)] oder [Ausschneiden (Cut)].

 Fahren Sie mit dem nächsten Schritt fort, wenn Sie Seiten aus dem Dokument ausgeschnitten haben.

 Fahren Sie mit dem Schritt 7 fort, wenn Sie Seiten aus dem Dokument kopiert haben.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.

5 Klicken Sie auf [Speichern (Save)], um das Dokument zu speichern.

Das Fenster Dokument speichern wird angezeigt.

6 Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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7 Wählen Sie im Dokumentfenster die Box oder den Ordner aus, in dem Sie die Seiten speichern 
wollen.

8 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

9 Wählen Sie [Bearbeiten (Edit)] > [Einfügen (Paste)].

Das Dokument, das die kopierten Seiten enthält, wird in der ausgewählten Box oder im gewünschten Ordner 
erstellt.
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Seiten aus einem Dokument löschen
Sie können Seiten aus einem Dokument löschen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, dessen Seiten Sie löschen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die Kennwort-
eingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie im Dokumentfenster das Dokument aus, dessen Seiten Sie löschen wollen und klicken 
Sie auf [Bearbeiten (Edit)].

Die Seiten des Dokuments werden angezeigt und der Dokumentstatus wechselt in den Bearbeitungsmodus.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.
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4 Markieren Sie die Kontrollkästchen der Seiten, die Sie löschen wollen, und wählen Sie 
[Bearbeiten (Edit)] > [Löschen (Delete)].

Der Bestätigungsdialog erscheint.

5 Klicken Sie auf [OK].

Die ausgewählten Seiten werden gelöscht.

6 Klicken Sie auf [Speichern (Save)], um das Dokument zu speichern.

Das Fenster Dokument speichern wird angezeigt.

7 Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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Eine leere Seite in ein Dokument einfügen
Sie können eine leere Seite in ein Dokument einfügen. Sie können eine andere Größe für die Seite auswählen.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, in das Sie eine leere Seite einfügen wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie im Dokumentfenster das Dokument aus, in das Sie eine leere Seite einfügen wollen 
und klicken Sie auf [Bearbeiten (Edit)].

Die Seiten des Dokuments werden angezeigt und der Dokumentstatus wechselt in den Bearbeitungsmodus.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.

4 Klicken Sie auf den Bereich zwischen den Seiten, in den Sie eine leere Seite einfügen wollen.

Die Pfeilmarken bewegen sich auf den Bereich zwischen den Seiten, auf den Sie geklickt haben.



3.BEDIENUNG ÜBER EINEN CLIENTCOMPUTER

Dokumentseiten bearbeiten    89

BED
IEN

U
N

G
 Ü

BER EIN
EN

 CLIEN
TCO

M
PU

TER

5 Wählen Sie [Layout] > [Leere Seite einfügen (Insert Blank Page)].

Das Fenster Leere Seite einfügen wird angezeigt.

6 Wählen Sie das Papierformat und die Ausrichtung für die leere Seite aus und klicken Sie auf [OK].

Eine leere Seite wird zwischen den Seiten eingefügt.

Tipp
Die verfügbaren Seitengrößen sind modellabhängig.

7 Klicken Sie auf [Speichern (Save)].

Das Fenster Dokument speichern wird angezeigt.
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8 Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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Seiten innerhalb des Dokuments verschieben
Sie können Seiten innerhalb eines Dokuments verschieben, um ihre Reihenfolge zu ändern.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, dessen Seiten Sie neu anordnen wollen. 

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Wählen Sie im Dokumentfenster das Dokument aus, dessen Seiten Sie neu anordnen wollen und 
klicken Sie auf [Bearbeiten (Edit)].

Die Seiten des Dokuments werden angezeigt und der Dokumentstatus wechselt in den Bearbeitungsmodus.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.

4 Markieren Sie die Kontrollkästchen der Seiten, die Sie verschieben wollen, und wählen Sie 
[Bearbeiten (Edit)] > [Ausschneiden (Cut)].

Die ausgewählten Seiten werden in die Zwischenablage kopiert und aus dem Dokument gelöscht.
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Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.

5 Klicken Sie auf den Bereich zwischen den Seiten, in den Sie die kopierten Seiten einfügen wollen.

Die Pfeilmarken bewegen sich auf den Bereich zwischen den Seiten, auf den Sie geklickt haben.

6 Wählen Sie [Bearbeiten (Edit)] > [Einfügen (Paste)].

Die kopierten Seiten werden zwischen die Seiten eingefügt.

7 Wiederholen Sie die Schritte 4 bis 6, um weitere Seiten neu anzuordnen.

8 Wenn die gewünschte Reihenfolge erreicht ist, klicken Sie auf [Speichern (Save)].

Das Fenster Dokument speichern wird angezeigt.

9 Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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0.Dokumente verschieben und kombinieren

Sie können Dokumente zwischen Boxen und Ordnern verschieben. Sie können auch mehrere Dokumente zu einem 
Dokument zusammenfassen.

Dokumente verschieben
Sie können ein Dokument von einer Box oder einem Ordner in einen anderen verschieben, was beim Verwalten der 
Dokumente nützlich ist.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie verschieben wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die 
Kennworteingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie die Kontrollkästchen der Dokumente, die Sie verschieben wollen, und wählen Sie 
[Bearbeiten (Edit)] > [Ausschneiden (Cut)].

Die ausgewählten Dokumente werden in die Zwischenablage kopiert und aus der aktuellen Box oder dem 
aktuellen Ordner gelöscht.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.
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4 Wählen Sie im Dokumentfenster die Box oder den Ordner aus, in den Sie die Dokumente einfügen 
wollen.

5 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die Kennwort-
eingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

6 Wählen Sie [Bearbeiten (Edit)] > [Einfügen (Paste)].

Die Dokumente werden in der ausgewählten Box oder im ausgewählten Ordner erstellt.
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Dokumente zusammenführen
Sie können ein vollständiges Dokument kopieren und die Seiten in ein anderes Dokument einfügen.
Das einzufügende Dokument ist das Quelldokument und das Dokument, in dem die Seiten eingefügt werden, das 
Zieldokument.

1 Wählen Sie im Register [Dokumente (Documents)] innerhalb des Dokumentfensters die Box oder 
den Ordner mit dem Dokument, das Sie als Quelle verwenden wollen.

2 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die Kennwort-
eingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

3 Markieren Sie die Kontrollkästchen der Quelldokumente und wählen Sie [Bearbeiten (Edit)] > 
[Kopieren (Copy)].

Die ausgewählten Dokumente werden in die Zwischenablage kopiert.

Hinweis

Führen Sie möglichst keinen anderen Vorgang aus, solange Sie das e-Filing Dienstprogramm benutzen.
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4 Wählen Sie im Dokumentfenster die Box oder den Ordner aus, der das Zieldokument enthält.

5 Wenn Sie eine kennwortgeschützte Box gewählt haben, wird das Fenster für die Kennwort-
eingabe angezeigt. Geben Sie das Kennwort ein und klicken Sie auf [OK].

Hinweis

Wenn Sie bei der Box-Kennworteingabe mehrmals ein falsches Kennwort eingeben, wird die Anmeldung für eine 
definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird. Wenden Sie sich an 
Ihren Administrator, wenn die Meldung “Box gesperrt.” erscheint und Sie sich nicht mehr anmelden können.

Tipp
Anstelle des Box-Kennwortes können Sie auch das Administratorkennwort eingeben, um die Benutzerbox zu 
öffnen.

6 Wählen Sie im Dokumentfenster das Zieldokument aus und klicken Sie auf [Bearbeiten (Edit)].

Die Seiten des Dokuments werden angezeigt und der Dokumentstatus wechselt in den Bearbeitungsmodus.

Hinweis

Wenn der Dokumentstatus “In Gebrauch” lautet, können Sie nicht in den Bearbeitungsmodus wechseln, weil das 
Dokument gerade von einem anderen Anwender bearbeitet wird.

7 Klicken Sie auf den Bereich zwischen den Seiten, in dem Sie die Dokumente zusammenführen 
wollen.

Die Pfeilmarken bewegen sich auf den Bereich zwischen den Seiten, auf den Sie geklickt haben.
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8 Wählen Sie [Bearbeiten (Edit)] > [Einfügen (Paste)].

Die kopierten Dokumente werden zwischen die definierten Seiten eingefügt.

9 Klicken Sie auf [Speichern (Save)].

Das Fenster Dokument speichern wird angezeigt.

10Geben Sie den Dokumentnamen ein und klicken Sie auf [Speichern (Save)].

 Wenn Sie das Dokument umbenennen, wird es als neues Dokument gespeichert. Wenn Sie den Namen nicht 
ändern, wird das Originaldokument überschrieben.

 Der Dokumentstatus kehrt in den Ansichtsmodus zurück.

Hinweis

Schließen Sie das Fenster Dokument speichern nicht, indem Sie auf das Symbol [X] klicken. Dies kann den 
weiteren Ablauf stören. Falls Sie das Fenster versehentlich durch einen Klick auf das Symbol [X] geschlossen 
haben, schalten Sie das System aus und wieder ein und wiederholen den Vorgang.
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0.System Administration

Dieser Abschnitt beschreibt die Systemverwaltung von e-Filing.

Als Systemadministrator anmelden
Führen Sie nach dem Start des e-Filing Dienstprogramms folgende Schritte aus, um sich als Administrator 
anzumelden.

Hinweis

“Systemadministrator” und “Anwender mit Administratorrechten” sind in dieser Anleitung wie folgt definiert.
 Systemadministrator: 

Anwender mit der Rollenzuweisung als Administrator
 Anwender mit Administratorrechten: 

Anwender mit dem Benutzernamen “Admin”

1 Klicken Sie auf die Verknüpfung zur Anmeldung rechts oben auf der Seite.

Die Seite für die Administratoranmeldung wird angezeigt.

2 Geben Sie das Administratorkennwort ein und klicken Sie auf [Anmelden (Login)].

Das Register [Administration] wird in den Hauptregistern angezeigt.

Hinweis

 Wenn Sie bei der Anmeldung im e-Filing Dienstprogramm mehrmals ein falsches Kennwort eingeben, wird die 
Anmeldung für eine definierte Zeitspanne gesperrt, da dies als unberechtigter Zugriffsversuch gewertet wird.

 Zum Schutz der Administratorfunktionen vor einem unbefugten Zugriff, sollten Sie sich beim Verlassen des 
e-Filing Dienstprogramms wieder abmelden und den Browser schließen.

Tipp
Das Administratorkennwort entspricht dem Kennwort, das in TopAccess oder über das Bedienfeld für den 
Administrator festgelegt wurde. Die Voreinstellung für das Administratorkennwort ist “123456”, wenn Sie es 
nicht geändert haben.



4.SYSTEMVERWALTUNG FÜR e-Filing

System Administration    101

SYSTEM
VERW

ALTU
N

G
 FÜ

R e-Filing

Administrator Register 
Das Register [Administration] ermöglicht dem Systemadministrator die Verwaltung der e-Filing-Daten. Es ist nur 
sichtbar, wenn Sie sich als Systemadministrator angemeldet haben.

Tipp
Der Administrator kann über TopAccess im Administratormodus auch die e-Filing-Benachrichtigungen einrichten. Zu 
weiteren Informationen über Benachrichtigungen für e-Filing siehe nachfolgende Referenz:
TopAccess - [Administration] - [Wartung (Maintenance)] Elemente - Benachrichtigung Einstellungen - 
Benachrichtigung für Systemereignisse

 [Box Management] Seite
Über diese Seite können Sie nicht mehr benötigte oder beschädigte Benutzerboxen manuell löschen. Verwenden Sie 
diese Funktion, um internen Datenspeicher zurückzugewinnen. Sie können auch Benutzerboxen freigeben, die durch 
eine falsche Kennworteingabe gesperrt wurden.

1. Verfügbarer Speicher für e-Filing
Zeigt die freie Kapazität des internen Speichers für e-Filing an.

2. Box Nummer / Box Name / Verwendete Kapazität / Status
Zeigt eine Liste aller Benutzerboxen an. Wenn Sie auf die Schaltfläche mit der Box-Nummer oder dem Box-
Namen klicken, wird das Fenster der Box-Eigenschaften geöffnet, das die einzelnen Eigenschaften der Box 
anzeigt. Ist die Benutzerbox gesperrt, wird dies als Status angezeigt.
Um eine gesperrte Benutzerbox zu löschen oder freizugeben, wählen Sie das Kontrollfeld links neben den 
Eigenschaften und klicken auf [Löschen (Delete)] oder [Sperre aufheben (Unlock)].

3. [Löschen (Delete)]
Klicken Sie auf diese Schaltfläche, um die ausgewählten Boxen zu löschen. Bevor Sie hier klicken, sollten Sie 
sicherstellen, dass nur die Kontrollkästchen der zu löschenden Boxen markiert sind.

Tipp

 Sie können die öffentliche Box nicht löschen.
 Hinweise zum Löschen von Benutzerboxen finden Sie in der nachfolgenden Referenz:
 S.102 “Boxen löschen”

4. [Sperre aufheben (Unlock)]
Klicken Sie auf diese Schaltfläche, um die ausgewählten Boxen freizugeben. Bevor Sie hier klicken, sollten Sie 
sicherstellen, dass nur die Kontrollkästchen der freizugebenden Boxen markiert sind.

Tipp
Hinweise zur Freigabe von Benutzerboxen finden Sie in der nachfolgenden Referenz:
 S.103 “Boxen freigeben”

1

3
4

2
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Internen Datenspeicher in e-Filing verwalten
Der Administrator sollte die Belegung des internen Datenspeichers regelmäßig überprüfen, um sicherzustellen, dass 
der Speicher für e-Filing-Funktionen ausreicht.
Administratoren können wie allgemeine Anwender die e-Filing Benutzerboxen, Ordner und die 
Dokumentenverwaltung nutzen. Zu den Einzelheiten dieser Bedienungsvorgänge siehe nachfolgende Referenzen:
 S.39 “Benutzerboxen/Ordner verwalten”
 S.50 “Dokumente verwalten”
Dieser Abschnitt beschreibt die Administratorfunktionen zum Löschen von Boxen und zur Freigabe von Benutzer-
boxen, die aufgrund einer falschen Kennworteingabe gesperrt wurden.

 Boxen löschen
Sie können Boxen in der e-Filing-Box manuell löschen, wenn Daten, z.B. durch einen Fehler des Internen 
Datenspeichers, beschädigt wurden und daher nicht mehr verwendbar sind.

1 Melden Sie sich auf der Administratorseite an.
 S.100 “Als Systemadministrator anmelden”
Die Box-Verwaltungsseite wird angezeigt.

Hinweis

 Es wird empfohlen, die Dokumente in den Boxen zu archivieren, bevor die Boxen gelöscht werden. Wenn die 
Boxen einmal gelöscht sind, können Sie die Dokumente in den Boxen nicht wieder herstellen.
 S.63 “Dokumente archivieren”

 Mit dem Backup/Restore Dienstprogramm der Client Utilities/User Documentation DVD können Sie die Daten 
in den Boxen sichern.

Tipp
Wenn Sie auf die Boxnummer oder den Boxnamen klicken, werden die Boxeigenschaften angezeigt.

2 Markieren Sie die Kontrollkästchen der Benutzerboxen, die Sie löschen wollen, und klicken Sie 
auf [Löschen (Delete)].

Das Bestätigungs-Dialogfeld erscheint.

Tipp
Zu weiteren Informationen über die Box-Verwaltung siehe nachfolgende Referenz:
 S.101 “[Box Management] Seite”

3 Klicken Sie auf [OK].

Die ausgewählten Benutzerboxen werden aus e-Filing gelöscht.
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 Boxen freigeben
Wenn in der Kennwortrichtlinie das Sperren von e-Filing aktiviert ist, wird nach einer mehrmaligen Falscheingabe des 
Box-Kennworts die Box für einen bestimmten Zeitraum gesperrt. Der Systemadministrator kann gesperrte 
Benutzerboxen freigeben.

Hinweis

Die Kennwort-Richtlinie wird in TopAccess eingestellt. Zu den Einzelheiten der Kennwortrichtlinie siehe nachfolgende 
Referenz:
TopAccess - [Administration] - [Sicherheit (Security)] Elemente - Kennwortrichtlinie Einstellung - Richtlinie für 
e-Filing Boxen, SicheresPDF, SNMPv3, Klonen und sicheren Empfang festlegen

1 Melden Sie sich auf der Administratorseite an.
 S.100 “Als Systemadministrator anmelden”
Die Box-Verwaltungsseite wird angezeigt.

Tipp

 Für gesperrte Boxen wird als Status “Gesperrt” angezeigt.
 Das Fenster "Box-Eigenschaften" wird aufgerufen, wenn Sie auf die Box-Nummer oder den Box-Namen 

klicken.

2 Markieren Sie die Kontrollkästchen der Boxen, deren Sperre Sie aufheben wollen, und klicken Sie 
auf [Sperre aufheben (Unlock)].

Die Sperre der ausgewählten Boxen wird aufgehoben.

Tipp
Zu weiteren Informationen über die Box-Verwaltung siehe nachfolgende Referenz:
 S.101 “[Box Management] Seite”
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